
3What-If Analysis, 
Charting, and Working 
with Large Worksheets

• Rotate text in a cell

• Create a series of month names

• Copy, paste, insert, and delete cells

• Format numbers using format symbols

• Freeze and unfreeze titles

• Show and format the system date

• Use absolute cell references in a 
formula

• Use the IF function to perform a 
logical test

• Use the Format Painter button to 
format cells

• Create a 3-D Pie chart on a separate 
chart sheet 

• Color and rearrange worksheet tabs

• Change the worksheet view

• Answer what-if questions

• Goal seek to answer what-if questions

Objectives
You will have mastered the material in this chapter when you can:

Microsoft Offi ce Excel 2007
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Introduction
Worksheets normally are much larger than those created in the previous chapters, often 
extending beyond the size of the window. Because you cannot see the entire worksheet on 
the screen at one time, working with a large worksheet sometimes can be frustrating. This 
chapter introduces several Excel commands that allow you to control what displays on the 
screen so you can view critical parts of a large worksheet at one time. One command lets 
you freeze the row and column titles so Excel always displays them on the screen. Another 
command splits the worksheet into separate window panes so you can view different parts 
of a worksheet on the screen at one time. Hiding the Ribbon will allow a larger portion of 
the worksheet to be visible.

When you set up a worksheet, you should use cell references in formulas whenever 
possible, rather than constant values. The use of a cell reference allows you to change a 
value in multiple formulas by changing the value in a single cell. The cell references in 
a formula are called assumptions. Assumptions are values in cells that you can change to 
determine new values for formulas. This chapter emphasizes the use of assumptions and 
shows how to use Excel to answer what-if questions such as, what happens to the semi-
annual operating income if you decrease the marketing expenses assumption by 2%? Being 
able to analyze quickly the effect of changing values in a worksheet is an important skill in 
making business decisions.

This chapter also introduces you to techniques that will enhance your ability to 
create worksheets and draw charts. From your work in Chapter 1, you are aware of how 
easily you can create charts. This chapter covers additional charting techniques that allow 
you to convey your message in a dramatic pictorial fashion such as an exploded 3-D Pie 
chart. This chapter also covers other methods for entering values in cells, such as allowing 
Excel to enter values for you based on a pattern of values that you create, and formatting 
these values. In addition, you will learn how to use absolute cell references and how to use 
the IF function to assign a value to a cell based on a logical test.

Project — Financial Projection Worksheet with 
What-If Analysis and Chart
The project in the chapter follows proper design guidelines and uses Excel to create the 
worksheet and pie chart shown in Figure 3–1. Campus Clothiers manufactures and sells 
customized clothing to college students on campuses around the country. Each June and 
December, the director of fi nance and accounting submits a plan to the management team 
to show projected monthly revenues, costs of goods, gross margin, expenses, and operating 
income for the next six months. The director requires an easy-to-read worksheet that 
shows fi nancial projections for the next six months. The worksheet should allow for quick 
analysis if projections for certain numbers change, such as the percentage of expenses 
allocated to marketing. In addition, a 3-D Pie chart is required that shows the projected 
operating income contribution for each of the six months. 

3 What-If Analysis, Charting, and 
Working with Large Worksheets
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Figure 3–1 

(a)  Worksheet

(b)  3-D Pie Chart
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The requirements document for the Campus Clothiers Semiannual Financial 
Projection worksheet is shown in Figure 3–2. It includes the needs, source of data, 
summary of calculations, chart requirements, and other facts about its development.

Figure 3–2

Correctness
Studies have shown that 
more than 25 percent of 
all business worksheets 
have errors. If you are 
not careful entering 
data and formulas, 
then your worksheet 
is prone to errors. You 
can ensure correctness 
in your formulas by 
carefully checking them 
using Range Finder. The 
Formula Auditing group 
on the Formulas tab on 
the Ribbon also can be 
helpful when verifying 
formulas. 
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Excel’s Usefulness
Just a few short years 
ago, a what-if question 
of any complexity only 
could be answered 
using a large, expensive 
computer programmed 
by highly paid 
computer professionals. 
Generating a result 
could take days. Excel 
gives the noncomputer 
professional the ability 
to get complex business-
related questions 
answered instantaneously 
and economically.
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Overview
As you read this chapter, you will learn how to create the worksheet shown in Figure 3–1 

by performing these general tasks:
• Create a series of month names
• Use absolute cell references in a formula
• Use the IF function to perform a logical test
• Use the Format Painter button to format cells
• Create a 3-D Pie chart on a separate chart sheet
• Answer what-if questions
• Manipulate large worksheets

General Project Decisions
While creating an Excel worksheet, you need to make several decisions that will determine 
the appearance and characteristics of the fi nished worksheet. As you create the worksheet 
required to meet the requirements shown in Figure 3–2, you should follow these general 
guidelines:

1. Plan the layout of the worksheet. The requirements state that six months are necessary 
in the worksheet. It is therefore sensible to place the months across columns so that the 
fi nancial headings can be placed in rows. The what-if assumptions should not clutter the 
worksheet, but they should be placed in an easily located portion of the worksheet.  

2. Determine the necessary formulas and functions needed. Except for the monthly sales 
numbers, the remaining numbers in the main portion of the worksheet are calculated based 
on the numbers in the what-if portion of the worksheet. The formulas are stated in the 
requirements document (Figure 3–2). The Bonus expense is included only if a certain condition 
is met. A function can check for the condition and include the bonus when necessary.  

3. Identify how to format various elements of the worksheet. Sales and Expenses are two 
distinct categories of fi nancial data and should be separated visually. Gross Margin and 
Total Expenses should stand out because they are subtotals. The Operating Income is the 
key piece of information being calculated in the worksheet and, therefore, should be 
formatted in such a manner as to draw the reader’s attention. The what-if assumptions 
should be formatted in a manner which indicates that they are separate from the main 
area of the worksheet.

4. Specify how the chart should convey necessary information. The requirements document 
indicates that the chart should be a 3-D Pie chart and emphasize the month with the 
greatest operating income. A 3-D Pie chart is a good way to compare visually a small set 
of numbers. The month, which is emphasized, also should appear closer to the reader in 
order to draw the reader’s attention. 

5. Perform what-if analysis and goal seeking using the best techniques. What-if analysis allows 
you quickly to answer questions regarding various predictions. In Campus Clothiers 
Semiannual Financial Projection worksheet, the only cells that you should change when 
performing what-if analysis are those in the what-if portion of the worksheet. All other 
values in the worksheet, except for the projected sales, are calculated. Goal seeking allows 
you automatically to modify values in the what-if area of the worksheet based on a goal 
that you have for another cell in the worksheet. 

(continued)

Plan 
Ahead

Project — Financial Projection Worksheet with What-If Analysis and Chart   EX 165
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(continued)

In addition, using a sketch of the worksheet can help you visualize its design. The sketch 
of the worksheet (Figure 3-3a) consists of titles, column and row headings, location of data 
values, calculations, and a rough idea of the desired formatting. The sketch of the 3-D Pie 
chart (Figure 3–3b) shows the expected contribution of each month’s operating income to the 
semiannual operating income. The projected monthly sales will be entered in row 4 of 
the worksheet. The assumptions will be entered below the operating income (Figure 3–3a). 
The projected monthly sales and the assumptions will be used to calculate the remaining 
numbers in the worksheet.

When necessary, more specifi c details concerning the above guidelines are presented at 
appropriate points in the chapter. The chapter also will identify the actions you perform 
and decisions made regarding these guidelines during the creation of the worksheet shown 
in Figure 3–1 on page EX 163.

Plan
Ahead

Figure 3–3

(a) Worksheet

(b) 3-D Pie Chart
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With a good understanding of the requirements document, an understanding of the 
necessary decisions, and a sketch of the worksheet, the next step is to use Excel to create 
the worksheet.

Project — Financial Projection Worksheet with What-If Analysis and Chart   EX 167

Table 3–1 Campus Clothiers Semiannual Financial 
Projections Data and What-If Assumptions

Projected Monthly Total Net 
Revenues

January $3,383,909.82

February   6,880,576.15

March   9,742,702.37

April   4,818,493.53

May   4,566,722.63

June   8,527,504.39

What-If Assumptions

Bonus $100,000.00

Commission 3.25%

Margin 61.00%

Marketing 9.00%

Research and Development 5.75%

Revenue for Bonus $4,750,000.00

Support, General, and Administrative 17.00%

To Start Excel

If you are using a computer to step through the project in this chapter and you want 
your screen to match the fi gures in this book, you should change your computer’s reso-
lution to 1024 � 768. For information about how to change a computer’s resolution, see 
page APP 36 in Appendix E.

The following steps, which assume Windows is running, start Excel based on a typical 
installation of Microsoft Offi ce on your computer. You may need to ask your instructor 
how to start Excel for your computer.

1  Click the Start button on the Windows taskbar to display the Start menu.

2  Point to All Programs on the Start menu and then point to Microsoft Offi ce in the All 
Programs submenu.

3  Click Microsoft Offi ce Excel 2007 on the Microsoft Offi ce submenu.

4  If the Excel window is not maximized, click the Maximize button next to the Close button 
on its title bar to maximize the window.

5  If the worksheet window in Excel is not maximized, click the Maximize button next to the 
Close button on its title bar to maximize the worksheet window within Excel.

 

The Startup Submenu
Any application on the 
Startup submenu starts 
automatically when 
you turn your computer 
on. To add Excel to the 
Startup submenu, do 
the following: (1) Click 
the Start button on the 
Windows taskbar, point 
to All Programs on the 
Start menu, and then 
point to Microsoft Offi ce 
on the All Programs 
submenu; (2) Right-drag 
Microsoft Offi ce Excel 
2007 from the Microsoft 
Offi ce submenu to the 
Startup submenu; (3) 
When the shortcut menu 
appears, click Copy Here. 
The next time you turn 
your computer on, Excel 
will start automatically. 

B
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To Enter the Worksheet Titles, Change Workbook Properties, 
Apply a Theme, and Save the Workbook

The worksheet contains two titles, one in cell A1 and another in cell A2. In the 
previous chapters, titles were centered across the worksheet. With large worksheets that 
extend beyond the size of a window, it is best to enter titles in the upper-left corner as 
shown in the sketch of the worksheet in Figure 3–3a. The following steps enter the 
worksheet titles and save the workbook.

1  Click cell A1 and then enter Campus Clothiers as the worksheet title.

2  Click cell A2 and then enter Semiannual Projected Gross Margin, Expenses, and 
Operating Income as the worksheet subtitle and then press the ENTER key.

3  Click the Offi ce Button, click Prepare on the Offi ce Button menu, and then click Properties.

4  Update the document properties with your name and any other relevant information.

5  Click the Close button in the Document Properties pane. 

6  Apply the Trek theme to the worksheet by clicking the Themes button on the Page Layout 
tab on the Ribbon and then return to the Home tab on the Ribbon.

7  With a USB fl ash drive connected to one of the computer’s USB ports, click the Save button 
on the Quick Access Toolbar.

8  When Excel displays the Save As dialog box, type Campus Clothiers Semiannual 
Financial Projection in the File name text box.

9  If necessary, click UDISK 2.0 (E:) in the Save in list (your USB fl ash drive may have a different 
name and letter). Click the Save button in the Save As dialog box to save the workbook.

 

Rotating Text and Using the Fill Handle to Create 
a Series
The data on the worksheet, including month names and the What-If Assumptions section, 
now can be added to the worksheet. 

Plan the layout of the worksheet.
The design of the worksheet calls specifi cally for only six months of data. Because there 
always will be only six months of data in the worksheet, the months should be placed across 
the top of the worksheet as column headings rather than as row headings. There are more 
data items regarding each month than there are months, and it is possible that more expense 
categories could be added in the future. A proper layout, therefore, includes placing the 
data items for each month as row headings. The What-If Assumptions section should be 
placed in an area of the worksheet that is easily accessible, yet does not impair the view 
of the main section of the worksheet. As shown in Figure 3–3a, the What-If Assumptions 
should be placed below the calculations in the worksheet.

Plan
Ahead

When you fi rst enter text, its angle is zero degrees (0°), and it reads from left 
to right in a cell. Text in a cell can be rotated counterclockwise by entering a number 
between 1° and 90° in the Alignment sheet in the Format Cells dialog box.

Rotating Text in a Cell
In Excel, you use the 
Alignment sheet of the 
Format Cells dialog box, 
as shown in Figure 3-5, to 
position data in a cell by 
centering, left-aligning, 
or right-aligning; 
indenting; aligning at the  
top, bottom, or center; 
and rotating. If you enter 
90 in the Degrees box in 
the Orientation area, the 
text will appear vertically 
and read from bottom to 
top in the cell. 

B
T
W

C6162_EXC_03.4c.indd   168C6162_EXC_03.4c.indd   168 3/6/07   3:31:58 PM3/6/07   3:31:58 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
3

To Rotate Text and Use the Fill Handle to Create a Series of Month Names

Chapters 1 and 2 used the fi ll handle to copy a cell or a range of cells to adjacent cells. The fi ll handle also can 
be used to create a series of numbers, dates, or month names automatically. The following steps enter the month 
name, January, in cell B3; format cell B3 (including rotating the text); and then use the fi ll handle to enter the 
remaining month names in the range C3:G3.

1
• Select cell B3.

• Type January as the cell entry 
and then click the Enter box.

• Click the Format Cells: Alignment 
Dialog Box Launcher on the 
Ribbon to display the Format 
Cells dialog box  (Figure 3-4).

Rotating Text and Using the Fill Handle to Create a Series   EX 169

cell B3 selected

Orientation area

Format Cells 
dialog box

Figure 3–4

2
• Click the 45° point in 

the Orientation area to 
move the Text hand in the 
Orientation area to the 45° 
point and to display 45 in the 
Degrees box (Figure 3–5).

45° point

Text hand 

Figure 3–5

OK button

Degrees box

Alignment tab

Home tab active
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3

• Click the OK button to rotate the 
text in cell B3 at a 45° angle and 
automatically increase the height 
of row 3 to best fi t the rotated 
text (Figure 3–6).

• Point to the fi ll handle on the 
lower-right corner of cell B3.

font in cell B3 
rotated 45° crosshair mouse 

pointer pointing 
to fi ll handle 

height of row 3 
automatically changed 
to best fi t to display 
rotated text

Figure 3–6
4

• Drag the fi ll handle to the 
right to select the range 
C3:G3. Do not release the 
mouse button (Figure 3–7).

fi ll handle 
dragged to 
cell G3

ScreenTip indicates 
proposed value of 
rightmost cell

Figure 3–7
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6
• Click the Auto Fill Options button to hide the Auto Fill Options menu.

• Click cell H3, type Total, and then press the RIGHT ARROW key.

Why is the word Total automatically formatted with the Heading 3 cell style and 45° rotation?

Excel tries to save you time by automatically recognizing the adjacent cell format in cell G3 
and applying it to cell H3. The Heading 3 cell style in cell G3 causes this action to occur.

5

• Release the mouse button to 
create a month name series 
January through June in the 
range B3:G3 and copy the format 
in cell B3 to the range C3:G3.

• Click the Auto Fill Options button 
below the lower-right corner of 
the fi ll area to display the Auto 
Fill Options menu (Figure 3–8).

What if I do not want to copy the 
format of cell B3 during the auto 
fi ll operation? 

In addition to creating a series of 
values, dragging the fi ll handle 
instructs Excel to copy the format 
of cell B3 to the range C3:G3. 
With some fi ll operations, you 
may not want to copy the formats 
of the source cell or range to the 
destination cell or range. If this is 
the case, click the Auto Fill 
Options button after the range 
fi lls (Figure 3–8) and then select 
the option you desire on the Auto 
Fill Options menu.

Auto Fill 
Options button

Auto Fill 
Options menu

months of year 
propagated using 
fi ll handle 

Figure 3–8

format of cell B3 
applied to range 
C3:G3

Q
&

A
Q

&
A

Other Ways

1. Enter start month in 
cell, apply formatting, 
right-drag fi ll handle 
in direction to fi ll, 
click Fill Months on 
shortcut menu 

2. Enter start month in 
cell, apply formatting, 
select range, click Fill 
button on Home tab 
on Ribbon, click Series, 
click AutoFill

Using the Auto Fill Options Menu
As shown in Figure 3–8, Fill Series is the default option that Excel uses to fi ll the 

area, which means it fi lls the destination area with a series, using the same formatting as 
the source area. If you choose another option on the Auto Fill Options menu, then Excel 
immediately changes the contents of the destination range. Following the use of the fi ll 
handle, the Auto Fill Options button remains active until you begin the next Excel operation. 
Table 3–2 summarizes the options on the Auto Fill Options menu.

Rotating Text and Using the Fill Handle to Create a Series   EX 171
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Table 3–2 Options Available on the Auto Fill Options Menu 

Auto Fill Option Description

Copy Cells Fill destination area with contents using format of source 
area. Do not create a series.

Fill Series Fill destination area with series using format of source 
area. This option is the default.

Fill Formatting Only Fill destination area using format of source area. No content 
is copied unless fi ll is series.

Fill Without Formatting Fill destination area with contents, without the formatting 
of source area.

Fill Months Fill destination area with series of months using format of 
source area. Same as Fill Series and shows as an option 
only if source area contains a month.

You can use the fi ll handle to create a series longer than the one shown in Figure 3–8. 
If you drag the fi ll handle past cell G3 in Step 4, Excel continues to increment the months 
and logically will repeat January, February, and so on, if you extend the range far enough 
to the right.

You can create several different types of series using the fi ll handle. Table 3–3 illustrates 
several examples. Notice in examples 4 through 7, 9, and 11 that, if you use the fi ll handle 
to create a series of numbers or nonsequential months, you must enter the fi rst item in the 
series in one cell and the second item in the series in an adjacent cell. Next, select both 
cells and drag the fi ll handle through the destination area.

Table 3–3 Examples of Series Using the Fill Handle 

Example Contents of Cell(s) Copied  Using 
the Fill Handle

Next Three Values of 
Extended Series

1 2:00 3:00, 4:00, 5:00

2 Qtr3 Qtr4, Qtr1, Qtr2

3 Quarter 1 Quarter 2, Quarter 3, Quarter 4

4 5-Jan, 5-Mar 5-May, 5-Jul, 5-Sep

5 2007, 2008 2009, 2010, 2011

6 1, 2 3, 4, 5 

7 430, 410 390, 370, 350

8 Sun Mon, Tue, Wed

9 Sunday, Tuesday Thursday, Saturday, Monday

10 4th Section 5th Section, 6th Section, 7th Section

11 �205, �208 �211, �214, �217

The Mighty Fill Handle
If you drag the fi ll handle 
to the left or up, Excel 
will decrement the series 
rather than increment 
the series. To copy a 
word, such as January 
or Monday, which Excel 
might interpret as the 
start of a series, hold 
down the CTRL key while 
you drag the fi ll handle 
to a destination area. If 
you drag the fi ll handle 
back into the middle of 
a cell, Excel erases the 
contents. 

B
T
W

C6162_EXC_03.4c.indd   172C6162_EXC_03.4c.indd   172 3/6/07   3:32:06 PM3/6/07   3:32:06 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
3

To Increase Column Widths and Enter Row Titles

In Chapter 2, the column widths were increased after the values were entered into the worksheet. Sometimes, 
you may want to increase the column widths before you enter the values and, if necessary, adjust them later. The 
following steps increase the column widths and then enter the row titles in column A down to What-If Assumptions 
in cell A18.

1
• Move the mouse pointer to 

the boundary between column 
heading A and column heading B 
so that the mouse pointer changes 
to a split double arrow.

• Drag the mouse pointer to the right 
until the ScreenTip displays, Width: 
35.00 (322 pixels). Do not release 
the mouse button (Figure 3–9).

Rotating Text and Using the Fill Handle to Create a Series   EX 173

split double arrow 
mouse pointer 

Figure 3–9

proposed width 
of column A 

2
• Release the mouse button to 

change the width of column A.

• Click column heading B and then 
drag through column heading G 
to select columns B through G.

• Move the mouse pointer to 
the boundary between column 
headings B and C and then drag 
the mouse to the right until the 
ScreenTip displays, Width: 14.00 
(133 pixels). Do not release the 
mouse button (Figure 3–10).

split double arrow 
mouse pointer 

Columns B 
through G 
selected 

Figure 3–10
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3
• Release the mouse button to 

change the width of columns B 
through G.

• Use the technique described in 
Step 1 to increase the width of 
column H to 15.00.

• Enter the row titles in the range 
A4:A18 as shown in Figure 3–11, 
but without the indents.

• Click cell A5 and then click the 
Increase Indent button on the 
Ribbon.

• Select the range A9:A13 and 
then click the Increase Indent 
button on the Ribbon.

• Click cell A19 to fi nish entering 
the row titles (Figure 3–11).

What happens when I click the 
Increase Indent button?

The Increase Indent button indents 
the contents of a cell to the right by 
three spaces each time you click it. 
The Decrease Indent button 
decreases the indent by three 
spaces each time you click it.

Increase Indent 
button

row titles

Decrease Indent 
button

Figure 3–11

indented 
row titles

Q
&

A

Other Ways

1. To indent, right-click 
range, click Format 
Cells on shortcut menu, 
click Alignment tab, 
click Left (Indent) in 
Horizontal list, type 
number of spaces to 
indent in Indent text 
box, click OK button

Copying a Range of Cells to a Nonadjacent 
Destination Area
As shown in the sketch of the worksheet (Figure 3–3a on page EX 166), the row titles in the 
Expenses area are the same as the row titles in the What-If Assumptions table, with the exception 
of the two additional entries in cells A21 (Margin) and A24 (Revenue for Bonus). Hence, the 
What-If Assumptions table row titles can be created by copying the range A9:A13 to the range 
A19:A23 and then inserting two rows for the additional entries in cells A21 and A24. The source 
area (range A9:A13) is not adjacent to the destination area (range A19:A23). The fi rst two chapters 
used the fi ll handle to copy a source area to an adjacent destination area. To copy a source area to 
a nonadjacent destination area, however, you cannot use the fi ll handle.

A more versatile method of copying a source area is to use the Copy button and 
Paste button on the Home tab on the Ribbon. You can use these two buttons to copy a 
source area to an adjacent or nonadjacent destination area. 

The Copy button copies the contents and format of the source area to the Offi ce 
Clipboard, a reserved place in the computer’s memory that allows you to collect text and 
graphic items from an Offi ce document and then paste them into any Offi ce document. 
The Copy command on the Edit menu or shortcut menu works the same as the Copy button. 
The Paste button copies the item from the Offi ce Clipboard to the destination area. 

Fitting Entries in a Cell
An alternative to 
increasing the column 
widths or row heights is to 
shrink the characters in the 
cell to fi t the current width 
of the column. To shrink 
to fi t, click Format Cells: 
Alignment Dialog Box 
Button Launcher on the 
Ribbon, and click Shrink to 
fi t in the Text control area. 
After shrinking entries to 
fi t in a cell, consider using 
the Zoom slider on the 
status bar to make the 
entries more readable. 
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To Copy a Range of Cells to a Nonadjacent Destination Area

The following steps use the Copy and Paste buttons to copy the range A9:A13 to the nonadjacent range A19:A23.

Copying a Range of Cells to a Nonadjacent Destination Area   EX 175

1
• Select the range A9:A13 and 

then click the Copy button on 
the Home tab on the Ribbon to 
copy the values and formats of 
the range A9:A13 to the Offi ce 
Clipboard.

• Click cell A19, the top cell in the 
destination area (Figure 3–12).

Why do I not need to select the 
entire destination area?

You are not required to select the 
entire destination area (range 
A19:A23) before clicking the Paste 
button. Excel needs to know only 
the upper-left cell of the destina-
tion area. In the case of a single 
column range, such as A19:A23, 
the top cell of the destination area 
(cell A19) also is the upper-left cell 
of the destination area.

Copy button

Paste button

top cell of 
destination area 

source area 
surrounded 
by marquee

Figure 3–12

Cut button

Q
&

A
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2
• Click the Paste button on the Ribbon 

to copy the values and formats of 
the last item placed on the Offi ce 
Clipboard (range A9:A13) to the 
destination area A19:A23.

• Scroll down so row 5 appears at the 
top of the window (Figure 3–13).

What if data already existed in the 
destination area?

When you complete a copy, 
the values and formats in the 
destination area are replaced 
with the values and formats 
of the source area. Any data 
contained in the destination 
area prior to the copy and paste 
is lost. If you accidentally delete 
valuable data, immediately click 
the Undo button on the Quick 
Access Toolbar. 

Paste button

Paste button 
arrow 

Figure 3–13

source area 
range A9:A13

destination area 
range A19:A23

Paste Options 
button 

Q
&

A

3
• Press the ESC key to remove the 

marquee from the source area 
and disable the Paste button on 
the Ribbon.

Other Ways

1. Right-click source area, 
click Copy on shortcut 
menu, right-click 
destination area, click 
Paste on shortcut menu

2. Select source area and 
point on border of 
range; while holding 
down CTRL key, 
drag source area to 
destination area

3.  Select source area, 
press CTRL+C, select 
destination area, press 
CTRL+V  

 Using the Paste Options Menu
After the Paste button is clicked, Excel immediately displays the Paste Options button, 

as shown in Figure 3–13. If you click the Paste Options button arrow and select an option 
on the Paste Options menu, Excel modifi es the most recent paste operation based on your 
selection. Table 3–4 summarizes the options available on the Paste Options menu.

Table 3–4 Options Available on the Paste Options Menu

Paste Option Description

Keep Source Formatting Copy contents and format of source area. This option is the default.

Match Destination Formatting Copy contents of source area, but not the format.

Values and Number Formatting Copy contents and format of source area for numbers or formulas, 
but use format of destination area for text.

Keep Source Column Widths Copy contents and format of source area. Change destination column 
widths to source column widths.

Formatting Only Copy format of source area, but not the contents.

Link Cells Copy contents and format and link cells so that a change to the cells 
in source area updates the corresponding cells in destination area.
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The Paste button on the Ribbon (Figure 3–13) includes an arrow, which displays a 
list of advanced paste options (Paste, Paste Special, and Paste Hyperlink). These options 
will be discussed when they are used.

An alternative to clicking the Paste button is to press the ENTER key. The ENTER 
key completes the paste operation, removes the marquee from the source area, and dis-
ables the Paste button so that you cannot paste the copied source area to other destination 
areas. The ENTER key was not used in the previous set of steps so that the capabilities of 
the Paste Options button could be discussed. The Paste Options button does not appear 
on the screen when you use the ENTER key to complete the paste operation.

Using Drag and Drop to Move or Copy Cells
You also can use the mouse to move or copy cells. First, you select the source area 

and point to the border of the cell or range. You know you are pointing to the border of 
the cell or range when the mouse pointer changes to a block arrow. To move the selected 
cell or cells, drag the selection to the destination area. To copy a selection, hold down the 
CTRL key while dragging the selection to the destination area. You know Excel is in copy 
mode when a small plus sign appears next to the block arrow mouse pointer. Be sure to 
release the mouse button before you release the CTRL key. Using the mouse to move or 
copy cells is called drag and drop.

Using Cut and Paste to Move Cells
Another way to move cells is to select them, click the Cut button on the Ribbon 

(Figure 3–12 on page EX 175) to remove them from the worksheet and copy them to 
the Offi ce Clipboard, select the destination area, and then click the Paste button on the 
Ribbon or press the ENTER key. You also can use the Cut command on the shortcut menu, 
instead of the Cut button.

Inserting and Deleting Cells in a Worksheet
At any time while the worksheet is on the screen, you can insert cells to enter new data or 
delete cells to remove unwanted data. You can insert or delete individual cells; a range of 
cells, rows, columns; or entire worksheets.

Inserting and Deleting Cells in a Worksheet   EX 177

To Insert a Row

The Insert command on the shortcut menu allows you to insert rows between rows 
that already contain data. According to the sketch of the worksheet in Figure 3–3a on 
page EX 166, two rows must be inserted in the What-If Assumptions table, one between 
Commission and Marketing for the Margin assumption and another between Research 
and Development and Support, General, and Administrative for the Revenue for Bonus 
assumption. The following steps accomplish the task of inserting the new rows into the 
worksheet.

Move It or Copy It
You may hear someone 
say, “Move it or copy it, 
it’s all the same.” No, it 
is not the same! When 
you move a cell, the data 
in the original location is 
cleared and the format 
is reset to the default. 
When you copy a cell, the 
data and format of the 
copy area remain intact. 
In short, you should 
copy cells to duplicate 
entries and move cells to 
rearrange entries. 
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Cutting
When you cut a cell or 
range of cells using the 
Cut command or Cut 
button, Excel copies 
the cells to the Offi ce 
Clipboard, but does not 
remove the cells from 
the source area until 
you paste the cells in 
the destination area by 
clicking the Paste button 
or pressing the ENTER key. 
When you complete the 
paste, Excel clears the 
cell entry and its formats 
from the source area. 

B
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Inserting Multiple 
Rows
If you want to insert 
multiple rows, you have 
two choices. First, you 
can insert a single row by 
using the Insert command 
on the shortcut menu 
and then repeatedly 
press F4 to keep inserting 
rows. Alternatively, you 
can select any number 
of existing rows before 
inserting new rows. For 
instance, if you want to 
insert fi ve rows, select 
fi ve existing rows in the 
worksheet, right-click the 
rows, and then click Insert 
on the shortcut menu. 
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2
• Click Insert on the shortcut menu to 

insert a new row in the worksheet 
by shifting the selected row 21 and 
all rows below it down one row.

• Click cell A21 in the new row and 
then enter Margin as the row title  
(Figure 3-15).

What is the resulting format of 
the new row?

The cells in the new row inherit 
the formats of the cells in the 
row above them. You can change 
this by clicking the Insert Options 
button that appears immediately 
above the inserted row. Following 
the insertion of a row, the Insert 
Options button lets you select 
from the following options: 
(1) Format Same As Above; 
(2) Format Same As Below; and 
(3) Clear Formatting. The Format 
Same as Above option is the 
default. The Insert Options button 
remains active until you begin the 
next Excel operation.

1
• Right-click row heading 21, the 

row below where you want to 
insert a row, to display the 
shortcut menu and the Mini 
toolbar (Figure 3–14).

row 
heading 21 

shortcut menu 

Figure 3–14

Insert 
command

Mini toolbar

row title Margin 
entered in new row Excel 

inserts 
new row 

Figure 3–15

original row 21 
shifted down 
one row 

Q
&

A
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3
• Right-click row heading 24 and 

then click Insert on the shortcut 
menu to insert a new row in the 
worksheet.

• Click cell A24 in the new row and 
then enter Revenue for Bonus 
as the row title (Figure 3–16).

What would happen if cells in 
the shifted rows are included in 
formulas?

If the rows that are shifted down 
include cell references in formulas 
located in the worksheet, Excel 
automatically adjusts the cell 
references in the formulas to 
their new locations. Thus, in Step 2, 
if a formula in the worksheet 
references a cell in row 21 before 
the insert, then the cell reference 
in the formula is adjusted to row 22 
after the insert.

row title Revenue 
for Bonus entered 
in new row 

Excel inserts 
new row

original row 24 
shifted down 
one row 

Figure 3–16

Q
&

A

1. On Home tab on Ribbon, 
click Insert, click Insert 
Sheet Rows

2.  Press CTRL+SHIFT+PLUS SIGN, 
click Entire Row, click OK 
button 

Other Ways

Inserting and Deleting Cells in a Worksheet   EX 179

Inserting Columns
You insert columns into a worksheet in the same way you insert rows. To insert 

columns, select one or more columns immediately to the right of where you want Excel 
to insert the new column or columns. Select the number of columns you want to insert. 
Next, click the Insert tab on the Ribbon and then click Insert Sheet Rows in the Insert 
gallery or click Insert on the shortcut menu. The Insert command on the shortcut menu 
requires that you select an entire column (or columns) to insert a column (or columns). 
Following the insertion of a column, Excel displays the Insert Options button, which 
allows you to modify the insertion in a fashion similar to that discussed earlier when 
inserting rows.

Inserting Single Cells or a Range of Cells
The Insert command on the shortcut menu or the Cells command on the Insert gallery 

of the Insert button on the Ribbon allows you to insert a single cell or a range of cells. You 
should be aware that if you shift a single cell or a range of cells, however, it no longer may 
be lined up with its associated cells. To ensure that the values in the worksheet do not get 
out of order, it is recommended that you insert only entire rows or entire columns. When 
you insert a single cell or a range of cells, Excel displays the Insert Options button so that 
you can change the format of the inserted cell, using options similar to those for inserting 
rows and columns. 

Dragging Ranges
You can move and insert 
a selected cell or range 
between existing cells by 
holding down the SHIFT 
key while you drag the 
selection to the gridline 
where you want to insert. 
You also can copy and 
insert by holding down 
the CTRL+SHIFT keys while 
you drag the selection to 
the desired gridline. 
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The Insert Options 
Button
When you insert 
columns or rows, Excel 
only displays the Insert 
Options button if formats 
are assigned to the 
leftmost column or top 
row of the selection. 

B
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Deleting Columns and Rows
The Delete button on the Ribbon or the Delete command on the shortcut menu 

removes cells (including the data and format) from the worksheet. Deleting cells is not 
the same as clearing cells. The Clear command, which was described earlier in Chapter 1 
on page EX 66, clears the data from the cells, but the cells remain in the worksheet. The 
Delete command removes the cells from the worksheet and shifts the remaining rows 
up (when you delete rows) or shifts the remaining columns to the left (when you delete 
columns). If formulas located in other cells reference cells in the deleted row or column, 
Excel does not adjust these cell references. Excel displays the error message #REF! in 
those cells to indicate a cell reference error. For example, if cell A7 contains the formula 
=A4+A5 and you delete row 5, Excel assigns the formula =A4+#REF! to cell A6 (originally 
cell A7) and displays the error message #REF! in cell A6. It also displays an Error Options 
button when you select the cell containing the error message #REF!, which allows you to 
select options to determine the nature of the problem.

Deleting Individual Cells or a Range of Cells
Although Excel allows you to delete an individual cell or range of cells, you should 

be aware that if you shift a cell or range of cells on the worksheet, it no longer may be 
lined up with its associated cells. For this reason, it is recommended that you delete only 
entire rows or entire columns.

Entering Numbers with Format Symbols
The next step in creating the Semiannual Financial Projection worksheet is to enter the what-if 
assumptions values in the range B19:B25. The numbers in the table can be entered and then 
formatted as in Chapters 1 and 2, or each one can be entered with format symbols. When a 
number is entered with a format symbol, Excel immediately displays it with the assigned 
format. Valid format symbols include the dollar sign ($), comma (,), and percent sign (%).

If you enter a whole number, it appears without any decimal places. If you enter a number 
with one or more decimal places and a format symbol, Excel displays the number with two 
decimal places. Table 3–5 illustrates several examples of numbers entered with format symbols. 
The number in parentheses in column 4 indicates the number of decimal places.

Table 3–5 Numbers Entered with Format Symbols 

Format 
Symbol

Typed in Formula Bar Displays in Cell 
 

Comparable Format

, 83,341 83,341 Comma (0)

1,675.8 1,675.80 Comma (2)

$ $278 $278 Currency (0)

$3818.54 $3,818.54 Currency (2)

$45,612.3 $45,612.30 Currency (2)

% 23% 23% Percent (0)

97.50% 97.50% Percent (2)

39.833% 39.83% Percent (2)

Ranges and Undo
Copying, deleting, 
inserting, and moving 
ranges of cells have 
the potential to render 
a worksheet useless. 
Carefully review these 
actions before continuing 
on to the next task. If you 
are not sure the action 
is correct, click the Undo 
button on the Quick 
Access Toolbar. 
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Freezing Worksheet Titles   EX 181

To Enter Numbers with Format Symbols

The following step enters the numbers in the What-If Assumptions table with format symbols.

1
• Enter 100,000.00 in 

cell B19, 3.25% in cell B20,
61.00% in cell B21, 9.00% 
in cell B22, 5.75% in 
cell B23, 4,750,000.00 
in cell B24, and 17.00% in 
cell B25 to display the 
entries using a format 
based on the format 
symbols entered with the 
numbers (Figure 3–17).

Figure 3–17

comma and decimal entered 
with number instructs Excel 
to format cell to Comma style 
with two decimal places 

1. Right-click range, click 
Format Cells on shortcut 
menu, click Number tab, 
click category in Category 
list, [select desired format], 
click OK button

2.  Press CTRL+1, click Number 
tab, click category in 
Category list, [select desired 
format], click OK button

Other Ways

Freezing Worksheet Titles
Freezing worksheet titles is a useful technique for viewing large worksheets that extend 
beyond the window. Normally, when you scroll down or to the right, the column titles 
in row 3 and the row titles in column A that defi ne the numbers no longer appear on the 
screen. This makes it diffi cult to remember what the numbers in these rows and columns 
represent. To alleviate this problem, Excel allows you to freeze the titles, so that Excel 
displays the titles on the screen, no matter how far down or to the right you scroll.

decimal and percent sign 
entered with number instructs 
Excel to format cell to Percent 
style with two decimal places 

Freezing Titles
If you want to freeze only 
column headings, select 
the appropriate cell in 
column A before you 
click the Freeze Panes 
button on the View tab 
on the Ribbon. If you 
only want to freeze 
row titles, then select 
the appropriate cell in 
row 1. To freeze both 
column headings and 
row titles, select the cell 
that is the intersection 
of the column and row 
titles before you click 
the Freeze Panes button 
on the View tab on the 
Ribbon. 
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2
• Click Freeze Panes in the Freeze 

Panes gallery to freeze column A 
and rows 1 through 3 (Figure 3–19).

What happens after I click the 
Freeze Panes 
command? 

Excel displays 
a thin black 
line on the 
right side of column A, indicating 
the split between the frozen 
row titles in column A and the rest 
of the worksheet. It also displays a 
thin black line below row 3, 
indicating the split between the 
frozen column titles in rows 1 
through 3 and the rest of the 
worksheet (Figure 3–19).

To Freeze Column and Row Titles

The following steps use the Freeze Panes button on the View tab on the Ribbon to freeze the worksheet title 
and column titles in rows 1, 2, and 3, and the row titles in column A.

1
• Press CTRL+HOME to 

select cell A1 and 
ensure that Excel 
displays row 1 and 
column A on the 
screen.

• Select cell B4.

• Click the View tab 
on the Ribbon and 
then click the 
Freeze Panes 
button on the 
Ribbon to 
display the 
Freeze Panes 
gallery (Figure 3–18).

Why is cell A1 
selected fi rst?

Before freezing the titles, it is important that Excel displays cell A1 in the upper-left corner of the 
screen. For example, if cell B4 was selected without fi rst selecting cell A1 to ensure Excel displays 
the upper-left corner of the screen, then Excel would freeze the titles and also hide rows 1 and 2. 
Excel thus would not be able to display rows 1 and 2 until they are unfrozen.

View tab
Freeze Panes 
button

Freeze 
Panes 
command 

cell below column 
titles and to the 
right of row titles 
to freeze 

Freeze Panes gallery

Figure 3–18

Q
&
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row titles in column 
A will remain on 
the screen when 
scrolling right 

Figure 3–19

column titles in 
fi rst three rows will 
remain on the screen 
when scrolling down 

thin black lines 
indicate border of 
frozen rows and 
columns

Q
&

A

Other Ways

1. Press ALT+W, F

C6162_EXC_03.4c.indd   182C6162_EXC_03.4c.indd   182 3/6/07   3:32:20 PM3/6/07   3:32:20 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
3

To Enter the Projected Monthly Sales

The following steps enter the projected monthly sales, listed earlier in Table 3–1 on 
page EX 167, in row 4 and compute the projected semiannual sales in cell H4.

1  If necessary, click the Home tab on the Ribbon.

2  Enter 3383909.82 in cell B4, 6880576.15 in cell C4, 9742702.37 in cell D4, 4818493.53 
in cell E4, 4566722.63 in cell F4, and 8527504.39 in cell G4.

3  Click cell H4 and then click the Sum button on the Ribbon twice to total the semiannual 
sales in cell H4 (Figure 3–20).

  

Displaying a System Date   EX 183

Sum button

projected 
semiannual sales 

columns B, C, and 
D not displayed 
when active cell 
is in column H

Figure 3–20

row titles frozen 
on screen

projected monthly 
sales for last three 
months 

Displaying a System Date
The sketch of the worksheet in Figure 3–3a on page EX 166 includes a date stamp on 
the right side of the heading section. A date stamp shows the date a workbook, report, 
or other document was created or the period it represents. In business, a report often 
is meaningless without a date stamp. For example, if a printout of the worksheet in this 
chapter were distributed to the company’s analysts, the date stamp would show when the 
six-month projections were made, as well as what period the report represents.

A simple way to create a date stamp is to use the NOW function to enter the system 
date tracked by your computer in a cell in the worksheet. The NOW function is one of 
14 date and time functions available in Excel. When assigned to a cell, the NOW function 
returns a number that corresponds to the system date and time beginning with December 31, 
1899. For example, January 1, 1900 equals 1, January 2, 1900 equals 2, and so on. Noon 
equals .5. Thus, noon on January 1, 1900 equals 1.5 and 6 P.M. on January 1, 1900 equals 
1.75. If the computer’s system date is set to the current date, which normally it is, then the 
date stamp is equivalent to the current date.

Excel automatically formats this number as a date, using the date and time format, 
mm/dd/yyyy hh:mm, where the fi rst mm is the month, dd is the day of the month, yyyy is 
the year, hh is the hour of the day, and mm is the minutes past the hour.

Your Age in Days
How many days have you 
been alive? Enter today’s 
date (e.g., 12/5/2008) in 
cell A1. Next, enter your 
birth date (e.g., 6/22/1986) 
in cell A2. Select cell A3 
and enter the formula 
=A1 - A2. Format cell A3 
to the General style using 
the Number Dialog Box 
Launcher. Cell A3 will 
display your age in days. 
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Updating the System 
Date and Time
If the system date and 
time appear in an active 
worksheet, Excel will 
not update the date and 
time in the cell until you 
enter data in another cell 
or complete some other 
activity, such as undoing 
a previous activity or 
pressing function key F9. 
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To Enter and Format the System Date

The following steps enter the NOW function and change the format from mm/dd/yyyy hh:mm to mm/dd/yyyy.

1
• Click cell H2 and 

then click the Insert 
Function box in the 
formula bar.

• When Excel displays 
the Insert Function 
dialog box, click the 
‘Or select a category’ 
box arrow, and then 
select Date & Time in 
the list.

• Scroll down in the 
Select a function list 
and then click NOW 
(Figure 3–21).

OK button 

Or select a category 
box arrow 

Insert Function 
dialog box

Insert Function box 
inserts equal sign 
in active cell and in 
formula bar

Figure 3–21

description of 
selected function 

Date & Time 
category

NOW function 
selected

2
• Click the OK button.

• When Excel 
displays the Function 
Arguments dialog 
box, click the OK 
button to display 
the system date and 
time in cell H2, using 
the default date 
and time format 
mm/dd/yyyy hh:mm.

• Right-click cell H2 to 
display the shortcut 
menu (Figure 3–22).

Format Cells 
command

system datecell H2 
assigned 
NOW 
function 

Figure 3–22

system time 

shortcut menu
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Displaying a System Date   EX 185

3
• Click Format Cells on the shortcut 

menu.

• When Excel displays the Format 
Cells dialog box, if necessary, click 
the Number tab.

• Click Date in the Category list. 
Scroll down in the Type list and 
then click 3/14/2001 to display a 
sample of the data in the active 
cell (H2) using the selected format 
in the Sample area (Figure 3–23).

Number tab

Format Cells 
dialog box

sample of date 
in cell H2 using 
selected format

Figure 3–23

Date category

desired format type

Excel displays 
system date with 
mm/dd/yyyy format

Figure 3–24

Q
&
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4
• Click the OK button in the Format 

Cells dialog box to display the sys-
tem date in the form mm/dd/yyyy 
(Figure 3–24).

How does Excel format a date?

In Figure 3–24, the date is 
displayed right-aligned in the cell 
because Excel treats a date as a 
number formatted to display as 
a date. If you assign the General 
format (Excel’s default format for 
numbers) to a date in a cell, the 
date is displayed as a number with 
two decimal places. For example, 
if the system time and date is 6:00 
PM on December 28, 2007 and the 
cell containing the NOW function is 
assigned the General format, then Excel displays the following number in the cell:

   39444.75

    
 Number of days since  time of day is 6:00 PM
 December 31, 1899  (portion of day complete)

The whole number portion of the number (39444) represents the number of days since 
December 31, 1899. The decimal portion of the number (.75) represents 6:00 PM as the time 
of day, at which point 3/4 of the day is complete. To assign the General format to a cell, click 
General in the Category list in the Format Cells dialog box (Figure 3–23).

Other Ways

1. On Formulas tab on 
Ribbon, click Date & 
Time, click NOW

2. Press CTRL+SEMICOLON 
(not a volatile date)

3. Press CTRL+SHIFT+# 
to format date to 
day-month-year
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To keep a cell reference constant when copying a formula or function, Excel uses a 
technique called absolute cell referencing. To specify an absolute cell reference in a formula, 
enter a dollar sign ($) before any column letters or row numbers you want to keep constant 
in formulas you plan to copy. For example, $B$20 is an absolute cell reference, while B20 is a 
relative cell reference. Both reference the same cell. The difference becomes apparent when 
they are copied to a destination area. A formula using the absolute cell reference $B$20 
instructs Excel to keep the cell reference B20 constant (absolute) in the formula as it copies 
it to the destination area. A formula using the relative cell reference B20 instructs Excel to 
adjust the cell reference as it copies it to the destination area. A cell reference with only one 
dollar sign before either the column or the row is called a mixed cell reference. Table 3–7 
gives some additional examples of absolute, relative, and mixed cell references. 

Table 3–6 Formulas for Determining Cost of Goods, Margin, Expenses, Total Expenses,
and Operating Income for January

Cell Row Title Formula Comment

B5 Cost of Goods Sold =B4 * (1 � B21) Sales times (1 minus Margin %)

B6 Gross Margin = B4 � B5 Sales minus Cost of Goods 

B9  Bonus =IF(B4 >= B24, B19, 0) Bonus equals value in B19 or 0

B10 Commission =B4 * B20 Sales times Commission %

B11 Marketing =B4 * B22 Sales times Marketing %

B12 Research and 
Development

=B4 * B23 Sales times Research and 
Development %

B13 Support, General, and 
Administrative

=B4 * B25 Sales times Support, General, and 
Administrative %

B14 Total Expenses =SUM(B9:B13) Sum of January Expenses

B16 Operating Income =B6 � B14 Gross Margin minus Total Expense

Determine necessary formulas and functions needed.
The next step is to enter the formulas that calculate the following values for January: cost of 
goods sold (cell B5), gross margin (cell B6), expenses (range B9:B13), total expenses (cell B14), 
and the operating income (cell B16). The formulas are based on the projected monthly sales 
in cell B4 and the assumptions in the range B19:B25. 

The formulas for each column (month) are the same, except for the reference to the 
projected monthly sales in row 4, which varies according to the month (B4 for January, C4 for 
February, and so on). Thus, the formulas for January can be entered in column B and then 
copied to columns C through G. Table 3–6 shows the formulas for determining the January 
costs of goods, gross margin, expenses, total expenses, and operating income in column B.

If the formulas are entered as shown in Table 3–6 in column B for January and then copied 
to columns C through G (February through June) in the worksheet, Excel will adjust the cell 
references for each column automatically. Thus, after the copy, the February Commission 
expense in cell C10 would be =C4 * C20. While the cell reference C4 (February Sales) is 
correct, the cell reference C20 references an empty cell. The formula for cell C7 should 
read =C4 * B20, rather than =C4 * C20, because B20 references the Commission % value in the 
What-If Assumptions table. In this instance, a way is needed to keep a cell reference in a 
formula the same, or constant, when it is copied.

Plan
Ahead

Absolute versus Relative Addressing
The next sections describe the formulas and functions needed to complete the calculations 
in the worksheet. 

Absolute Referencing
Absolute referencing is 
one of the more diffi cult 
worksheet concepts to 
understand. One point to 
keep in mind is that the 
paste operation is the only 
operation affected by an 
absolute cell reference. 
An absolute cell reference 
instructs the paste 
operation to keep the 
same cell reference as it 
copies a formula from one 
cell to another. 
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Table 3–7 Examples of Absolute, Relative, and Mixed Cell References

Cell 
Reference

Type of
Reference

Meaning

$B$20 Absolute cell reference Both column and row references remain the same when you copy 
this cell, because the cell references are absolute.

B$20 Mixed reference This cell reference is mixed. The column reference changes when 
you copy this cell to another column because it is relative. The row 
reference does not change because it is absolute.

$B20 Mixed reference This cell reference is mixed. The column reference does not change 
because it is absolute. The row reference changes when you copy 
this cell reference to another row because it is relative. 

B20 Relative cell reference Both column and row references are relative. When copied to 
another cell, both the column and row in the cell reference are 
adjusted to refl ect the new location.

To Enter a Formula Containing Absolute Cell References

The following steps enter the cost of goods formula = B4*(1 � $B$21) in cell B5 using Point mode. To enter 
an absolute cell reference, you can type the dollar sign ($) as part of the cell reference or enter it by pressing F4 with 
the insertion point in or to the right of the cell reference to change to absolute.

1
• Press CTRL+HOME and then click 

cell B5.

• Type = (equal sign), click cell B4, 
type *(1-b21 and then press F4 
to change b21 from a relative 
cell reference to an absolute cell 
reference.

• Type ) to complete the formula 
(Figure 3–25).

Is an absolute reference required 
in this formula?

No, because a mixed cell reference 
could have been used. The formula 
in cell B4 will be copied across 
columns, rather than down rows. 
So, the formula entered in cell B4 
in Step 1 could have been entered 
as =B4*(1-$B21), rather than 
=B4*(1-$B$21). That is, the formula 
could have included the mixed 
cell reference $B21, rather than 
the absolute cell reference $B$21. 
When you copy a formula across 
columns, the row does not change 
anyway. The key is to ensure that 
column B remains constant as you 
copy the formula across rows. To 
change the absolute cell reference 
to a mixed cell reference, continue 
to press the F4 key until you get 
the desired cell reference.

Enter box formula appears 
in formula bar

Figure 3–25

cell B4 is 
relative 

cell $B$21 is 
absolute

Q
&

A

Excel colors 
border of 
cells used in 
formula

C6162_EXC_03.4c.indd   187C6162_EXC_03.4c.indd   187 3/6/07   3:32:30 PM3/6/07   3:32:30 PM



EX 188   Excel Chapter 3   What-If Analysis, Charting, and Working with Large Worksheets

2
• Click the Enter box in the 

formula bar to display the result, 
1319724.83, in cell B5, instead of 
the formula (Figure 3–26).

Figure 3–26

projected 
January cost of 
goods sold 

formula 
assigned to cell 
B5 appears in 
formula bar

3
• Click cell B6, type = (equal sign), 

click cell B4, type — (minus sign) 
and then click cell B5.

• Click the Enter box in the formula 
bar to display the gross margin 
for January, 2064184.99, in cell B6  
(Figure 3-27).

formula 
appears in 
formula bar

Figure 3–27

active cell 
shows result 
of formula
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Making Decisions — The IF Function
According to the Request for New Workbook in Figure 3–2 on page EX 164, if the projected 
January sales in cell B4 is greater than or equal to the revenue for bonus in cell B24 
(4,750,000.00), then the January bonus value in cell B9 is equal to the bonus value in 
cell B19 (100,000.00); otherwise, cell B9 is equal to 0. One way to assign the January bonus 
value in cell B9 is to check to see if the sales in cell B4 equal or exceed the revenue for 
bonus amount in cell B24 and, if so, then to enter 100,000.00 in cell B9. You can use this 
manual process for all six months by checking the values for the corresponding month.

Because the data in the worksheet changes each time a report is prepared or the 
fi gures are adjusted, however, it is preferable to have Excel assign the monthly bonus to 
the entries in the appropriate cells automatically. To do so, cell B9 must include a formula 
or function that displays 100,000.00 or 0.00 (zero), depending on whether the projected 
January sales in cell B4 is greater than, equal to, or less than the revenue for bonus value 
in cell B24.

The IF function is useful when you want to assign a value to a cell based on a 
logical test. For example, using the IF function, cell B9 can be assigned the following IF 
function:

  =IF(B4>=$B$24, $B$19, 0)

 logical_test    value_if_true    value_if_false

The IF function instructs Excel that, if the projected January sales in cell B4 is 
greater than or equal to the revenue for bonus value in cell B24, then Excel should display 
the value 100000 in cell B19, in cell B9. If the projected January sales in cell B4 is less than 
the revenue for bonus value in cell B24, then Excel displays a 0 (zero) in cell B9.

The general form of the IF function is:

  =IF(logical_test, value_if_true, value_if_false)

The argument, logical_test, is made up of two expressions and a comparison operator. 
Each expression can be a cell reference, a number, text, a function, or a formula. Valid 
comparison operators, their meaning, and examples of their use in IF functions are shown 
in Table 3–8. The argument, value_if_true, is the value you want Excel to display in the 
cell when the logical test is true. The argument, value_if_false, is the value you want Excel 
to display in the cell when the logical test is false.

Table 3–8 Comparison Operators

Comparison 
Operator

Meaning Example

= Equal to =IF(H7 = 0, J6 ^ H4, L9 + D3)

< Less than =IF(C34 * W3 < K7, $K$6, L33 - 5)

> Greater than =IF(MIN(K8:K12) > 75, 1, 0)

>= Greater than or equal to =IF(P8 >= $H$6, J7 / V4, 7.5)

<= Less than or equal to =IF(G7 - G2 <= 23, L$9, 35 / Q2)

<> Not equal to =IF(B1 <> 0, ‘’No’’,’’Yes’’)

Logical Operators in 
IF Functions
IF functions can use logical 
operators, such as AND, 
OR, and NOT. For example, 
the three IF functions 
=IF(AND(B3>C3, D3<C5), 
“OK”, “Not OK”) and 
=IF(OR(C3>G5, D2<X3), 
“OK”, “Not OK”) and 
=IF(NOT(A6<H7), “OK”, 
“Not OK”) use logical 
operators. In the fi rst 
example, both logical 
tests must be true for 
the value_if_true OK to 
be assigned to the cell. 
In the second example, 
one or the other logical 
tests must be true for the 
value_if_true OK to be 
assigned to the cell. In the 
third example, the logical 
test A6<H7 must be false 
for the value_if_true OK 
to be assigned to the cell. 
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To Enter an IF Function

The following steps assign the IF function =IF(B4>=$B$24,$B$19,0) to cell B9. This IF function determines 
whether or not the worksheet assigns a bonus for January.

IF function typed 
in active cell 

Excel colors border 
of cells used in 
formula 

Figure 3–28

Excel colors border 
of cells used in 
formula  

if value in cell B4 is greater 
than or equal to 4,750,000, 
then bonus equals 100,000; 
otherwise, bonus equals 0 

1
• Click cell B9. Type 
=if(b4>=$b$24,

$b$19,0) in the cell 
(Figure 3–28).

2
• Click the Enter box 

in the formula bar 
to display 0 in 
cell B9 (Figure 3–29), 
because the value in 
cell B4 (3383909.82) 
is less than the value 
in cell B24 (4,750,000) 
(Figure 3-29).

Why does the value 
0 display in cell B9?

The value that Excel 
displays in cell B9 
depends on the 
values assigned to 
cells B4, B19, and 
B24. For example, if the value for January sales in cell B4 is reduced below 4,750,000.00, then 
the IF function in cell B9 will cause Excel to display a 0. If you change the bonus in cell B19 from 
100,000.00 to another number and the value in cell B4 is greater than or equal to the value in 
cell B24, it will change the results in cell B9 as well. Finally, increasing the revenue for bonus 
in cell B24 so that it is greater than the value in cell B4 will change the result in cell B9.

IF function 
assigned to 
cell B9 

Figure 3–29

Other Ways

1. On Formulas tab on 
Ribbon, click Logical 
button, click IF

2.  Click Insert Function 
box in formula bar, click 
Logical in ‘Or select a 
category list’, click IF in 
drop-down list, click 
OK button

Q
&

A

value of 0 assigned to cell 
B9 because value in cell 
B4(3383909.82) is less than 
value in cell B24 (4,750,000.00) 

C6162_EXC_03.4c.indd   190C6162_EXC_03.4c.indd   190 3/6/07   3:32:34 PM3/6/07   3:32:34 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
3

To Enter the Remaining January Formulas

The January commission expense in cell B10 is equal to the sales in cell B4 times 
the commission assumption in cell B20 (3.25%). The January marketing expense in cell 
B11 is equal to the projected January sales in cell B4 times the marketing assumption in 
cell B22 (9.00%). Similar formulas determine the remaining January expenses in cells B12 
and B13.

The total expenses value in cell B14 is equal to the sum of the expenses in the range 
B9:B13. The operating income in cell B16 is equal to the gross margin in cell B6 minus 
the total expenses in cell B14. The formulas are short, and therefore, they are typed in the 
following steps, rather than entered using Point mode.

1  Click cell B10. Type =b4*$b$20 and then press the DOWN ARROW key. Type =b4*$b$22 
and then press the DOWN ARROW key. Type =b4*$b$23 and then press the DOWN ARROW 
key. Type =b4*$b$25 and then press the DOWN ARROW key.

2  With cell B14 selected, click the Sum button on the Home tab on the Ribbon twice. Click 
cell B16. Type =b6-b14 and then press the ENTER key (Figure 3–30a).

3  Press CTRL+ACCENT MARK (`) to instruct Excel to display the formulas version of the 
worksheet (Figure 3–30b).

4  When you are fi nished viewing the formulas version, press CTRL+ACCENT MARK (`) to 
instruct Excel to display the values version of the worksheet.

Why should I view the formulas version of the worksheet?

Viewing the formulas version (Figure 3–30b) of the worksheet allows you to check the 
formulas assigned to the range B5:B16. Recall that formulas were entered in lowercase. 
You can see that Excel converts all the formulas from lowercase to uppercase.

Q
&

A
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Figure 3–30

Excel displays 
values for 
January

(a) Values Version

in formulas 
version, Excel 
displays formulas 
for January

(b) Formulas Version

Replacing a Formula 
with a Constant
You can replace a 
formula with its result so 
it remains constant. Do 
the following: (1) Click 
the cell with the formula; 
(2) press F2 or click in the 
formula bar; (3) press F9 
to display the value in 
the formula bar; and 
(4) press the ENTER key.

B
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To Copy Formulas with Absolute Cell References Using the Fill Handle

The following steps show how to use the fi ll handle to copy the January formulas in column B to the other 
fi ve months in columns C through G.

1
• Select the range 

B5:B16 and then 
point to the fi ll 
handle in the 
lower-right corner 
of cell B16 
(Figure 3–31).

source area 
is B5:B16

mouse pointer 
changes to 
cross hair

Figure 3–31
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2
• Drag the fi ll handle 

to the right to select 
the destination area 
C5:G16 to copy the 
formulas from the 
source area (B5:B16) 
to the destination 
area (C5:G16) and 
display the calculated 
amounts and Auto 
Fill Options button 
(Figure 3–32).

What happens to 
the formulas after 
the copy is made? 

Because the formulas 
in the range B5:B16 
use absolute cell 
references, the 
formulas still refer 
to the current values 
in the Assumptions 
table when the 
formulas are copied 
to the range C5:G16.

What happened to 
columns B, C, and D? 

As shown in 
Figure 3–32, as 
the fi ll handle is 
dragged to the 
right, columns B, C, 
and D no longer 
appear on the screen. Column A, however, remains on the screen, because the row titles 
were frozen earlier in this chapter. 

Auto Fill 
Options button

columns B (January), 
C (February), and 
D (March) do not 
appear

Figure 3–32

source area 
B5:B16 copied 
to destination 
area C5:G16 

projected June expenses 
based on projected June sales 
(cell G4) and assumptions in 
range B19:B25 

Q
&

A
Q

&
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To Determine Row Totals in Nonadjacent Cells 

The following steps determine the row totals in column H. To determine the row 
totals using the Sum button, select only the cells in column H containing numbers in 
adjacent cells to the left. If, for example, you select the range H5:H16, Excel will display 
0s as the sum of empty rows in cells H7, H8, and H15.
1  Select the range H5:H6. Hold down the CTRL key and select the range H9:H14 and cell H16 

as shown in Figure 3–33.

2  Click the Sum button on the Ribbon to display the row totals in column H (Figure 3–33).

Sum button

projected semiannual cost 
of goods, gross margin, 
expenses by category, and 
operating income 

Figure 3–33

To Unfreeze the Worksheet Titles and Save the Workbook

All the text, data, and formulas have been entered into the worksheet. The following 
steps unfreeze the titles and save the workbook using its current fi le name, Campus Clothiers 
Semiannual Financial Projection.

1  Press CTRL+HOME to select cell B4 and view the upper-left corner of the screen.

2  Click the View tab on the Ribbon and then click the Freeze Panes button on the Ribbon to 
display the Freeze Panes gallery (Figure 3–34). 

3  Click Unfreeze Panes in the Freeze Panes gallery to unfreeze the titles.

Error Messages
When Excel cannot 
calculate a formula, it 
displays an error message 
in a cell. These error 
messages always begin 
with a number sign (#). 
The more commonly 
occurring error messages 
are: #DIV/0! (tries to 
divide by zero); #NAME? 
(uses a name Excel does 
not recognize); #N/A 
(refers to a value not 
available); #NULL! 
(specifi es an invalid 
intersection of two 
areas); #NUM! (uses a 
number incorrectly); #REF 
(refers to a cell that is 
not valid); #VALUE! (uses 
an incorrect argument 
or operand); and ##### 
(cell not wide enough to 
display entire entry). 

B
T
W

Toggle Commands
Many of the commands 
on the Ribbon, in 
the galleries, and the 
shortcut keys function as 
a toggle. For example, 
if you click the Freeze 
Panes command on the 
Freeze Panes gallery,  the 
command changes to 
Unfreeze Panes the next 
time you view the gallery. 
These types of commands 
work like an on-off 
switch, or toggle. 
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4  Click the Home tab on the Ribbon and then click the Save button on the Quick Access 
Toolbar.

Why does pressing CTRL+HOME select cell B4?

When the titles are frozen and you press CTRL+HOME, Excel selects the upper-left cell of 
the unfrozen section of the worksheet. For example, in Step 1 of the previous steps, Excel 
selected cell B4. When the titles are unfrozen, then pressing CTRL+HOME selects cell A1.

Q
&

A

Save button

Freeze Panes 
button 

Unfreeze 
Panes 
command 

Freeze Panes 
gallery

Figure 3–34

View tab

Nested Forms of the IF Function
A nested IF function is one in which the action to be taken for the true or false 

case includes yet another IF function. The second IF function is considered to be nested, 
or layered, within the fi rst. Study the nested IF function below, which determines the 
eligibility of a person to vote. Assume the following in this example: (1) the nested IF 
function is assigned to cell K12, which instructs Excel to display one of three messages in 
the cell; (2) cell H12 contains a person’s age; and (3) cell I12 contains a Y or N, based on 
whether the person is registered to vote.

Formatting the Worksheet   EX 195

=IF(H12>=18, IF(I12="Y","Registered","Eligible and Not Registered"),"Not Eligible to Register")

The nested IF function instructs Excel to display one, and only one, of the following 
three messages in cell K12: (1) Registered; or (2) Eligible and Not Registered; or (3) Not 
Eligible to Register.

You can nest IF functions as deep as you want, but after you get beyond a nest of 
three IF functions, the logic becomes diffi cult to follow and alternative solutions, such as 
the use of multiple cells and simple IF functions, should be considered.

Formatting the Worksheet
The worksheet created thus far shows the fi nancial projections for the six-month 
period, from January to June. Its appearance is uninteresting, however, even though 
some minimal formatting (formatting assumptions numbers, changing the column 
widths, and formatting the date) was performed earlier. This section will complete the 
formatting of the worksheet to make the numbers easier to read and to emphasize the 
titles, assumptions, categories, and totals. 

Work Days
Assume that you have two 
dates: one in cell F3 and
the other in cell F4. The 
date in cell F3 is your 
starting date and the 
date in cell F4 is the 
ending date. To calculate 
the work days between 
the two dates (excludes 
weekends), use the 
following formula:  
=NETWORKDAYS(F3, F4). 
For this function to work, 
make sure the Analysis 
ToolPak add-in is installed. 
You can install it on the 
Add-Ins page of the Excel 
Options dialog box. 

B
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Home tab

C6162_EXC_03.4c.indd   195C6162_EXC_03.4c.indd   195 3/6/07   3:32:45 PM3/6/07   3:32:45 PM



EX 196   Excel Chapter 3   What-If Analysis, Charting, and Working with Large Worksheets

To Assign Formats to Nonadjacent Ranges

The numbers in the range B4:H16 are to be formatted as follows:
 1.  Assign the Currency style with a fl oating dollar sign to rows 4, 6, 9, 14, and 16.
 2.  Assign a Comma style to rows 5 and 10 through 13.
To assign a Currency style with a fl oating dollar sign, use the Format Cells dialog box rather than the 

Accounting Style button on the Ribbon, which assigns a fi xed dollar sign. Also use the Format Cells dialog box to 
assign the Comma style, because the Comma Style button on the Ribbon assigns a format that displays a dash (-) 
when a cell has a value of 0. The specifi cations for this worksheet call for displaying a value of 0 as 0.00 (see cell B9 
in Figure 3–35), rather than as a dash. To create a Comma style using the Format Cells dialog box, you can assign a 
Currency style with no dollar sign. The following steps assign formats to the numbers in rows 4 through 16.

36-point font 

14-point italic 
underlined font 

Figure 3–35

range A1:H2 
has orange 
background 

font in range 
A19:B25 is 8

height of rows 
1 through 3 
are best fi t 

Comma style

Currency style 
with fl oating 
dollar sign

Identify how to format various elements of the worksheet.
The worksheet will be formatted in the following manner so it appears as shown in Figure 3–35: 
(1) format the numbers; (2) format the worksheet title, column titles, row titles, and operating 
income row; and (3) format the assumptions table. Numbers in heading rows and total rows 
should be formatted with a currency symbol. Other dollar amounts should be formatted with a 
Comma style. The assumptions table should be diminished in its formatting so it does not distract 
from the main calculations and data in the worksheet. Assigning the data in the assumptions table 
a font size of 8-point would set it apart from other data formatted with a font size of 11-point.

Plan
Ahead

Selecting Nonadjacent 
Ranges
One of the more 
difficult tasks to 
learn is selecting 
nonadjacent ranges. 
To complete this task, 
do not hold down the 
CTRL key when you 
select the first range 
because Excel will 
consider the current 
active cell to be the 
first selection. Once the 
first range is selected, 
hold down the CTRL key 
and drag through the 
nonadjacent ranges. If 
a desired range is not 
visible in the window, 
use the scroll arrows 
to view the range. It is 
not necessary to hold 
down the CTRL key 
while you scroll.
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1
• Select the range 

B4:H4.

• While holding down 
the CTRL key, select 
the nonadjacent 
ranges B6:H6, 
B9:H9, B14:H14, and 
B16:H16, and then 
release the CTRL key.

• Click the Format 
Cells: Number 
Dialog Box 
Launcher on the 
Ribbon to display 
the Format Cells 
dialog box 
(Figure 3–36).
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Currency 
category 

Format Cells 
dialog box

Figure 3–36

nonadjacent ranges 
B4:H4, B6:H6, B9:H9, 
B14:H14, and B16:H16 
selected 

2
• Click Currency in the 

Category list, select 
2 in the Decimal 
places box, click $ 
in the Symbol list 
to ensure a dollar 
sign shows, and click 
the black font color 
($1,234.10) in the 
Negative numbers 
list (Figure 3–37).

Why was the 
particular style 
chosen for the 
negative numbers? 

In accounting, 
negative numbers 
often are shown 
with parentheses 
surrounding the 
value rather than 
with a negative sign 
preceding the value. 
Thus, the format 
(1,234.10) in the 
Negative numbers list was clicked. The data being used in this chapter contains no negative 
numbers. However, you must select a format for negative numbers, and you must be consistent 
if you are choosing different formats in a column, otherwise the decimal points may not line up. 

sample of 
format 

Figure 3–37

Currency style to appear 
with two decimal places, 
dollar sign, and negative 
numbers in parentheses 

Q
&

A

OK button

Format Cells:
Number Dialog 
Box Launcher
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3
• Click the OK button. 

• Select the range 
B5:H5.

• While holding down 
the CTRL key, select 
the range B10:H13, 
and then release the 
CTRL key.

• Click the Format 
Cells: Number Dialog 
Box Launcher on the 
Ribbon to display 
the Format Cells 
dialog box.

• When Excel displays 
the Format Cells 
dialog box, click 
Currency in the 
Category list, select 
2 in the Decimal 
places box, click 
None in the Symbol 
list so a dollar sign 
does not show, and click 
the black font color (1,234.10) in the Negative numbers list (Figure 3–38).

OK button

Figure 3–38

nonadjacent 
ranges B5:H5, and 
B10:H13 selected 

Comma style format is 
same as previous Currency 
style, but without dollar 
sign symbol 

4
• Click the OK button. 

• Press CTRL+HOME 
to select cell A1 
to display the 
formatted numbers 
as shown in 
Figure 3–39.

Figure 3–39

Comma style

Currency style 
with fl oating 
dollar sign 

Other Ways

1. Right-click range, click 
Format Cells on shortcut 
menu, click Number 
tab, click category in 
Category list, select 
format, click OK button

2. Press CTRL+1, click 
Number tab, click 
category in Category 
list, select format, click 
OK button
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To Format the Worksheet Titles

The following steps emphasize the worksheet titles in cells A1 and A2 by changing the font type, size, and 
color. The steps also format all of the row headers in column A with a Bold font style.

Formatting the Worksheet   EX 199

1
• Click the column A heading to 

select column A.

• Click the Bold button on the 
Ribbon to bold all of the data in 
column A (Figure 3–40).

Bold button

column A selected

Figure 3–40

2
• Click cell A1 to select it. Click 

the Font Size box arrow on the 
Ribbon, and then click 36 in the 
Font Size list.

• Click cell A2, click the Font Size 
box arrow, and then click 18 in the 
Font Size list (Figure 3–41).

Figure 3–41

font sizes of cell A1 
changed to 36 and 
font size of cell A2 
changed to 18 
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To Assign Cell Styles to Nonadjacent Rows and Colors to a Cell

The next step to improving the appearance of the worksheet is to format the heading 
in row 3 and the totals in rows 4, 14, and 16. The following steps format the heading in row 3 
with the Heading 3 cell style and the totals in rows 4, 14, and 16 with the Total cell style. 
Cell A4 also is formatted. 

1  Select the range A3:H3 and apply the Heading 3 cell style.

2  Select the range A6:H6 and while holding down the CTRL key, select the ranges A14:H14 
and A16:H16. 

3  Apply the Total cell style. 

4  Click cell A4, click the Fill Color button arrow on the Ribbon, and then click the Orange, 
Accent 1 color (column 5, row 1) on the Fill Color palette. 

5  Click the Font Color button arrow on the Ribbon, and then click the White, Background 1 
color (column 1, row 1) on the Font Color palette (Figure 3–43).

3
• Select the range A1:H2 and then 

click the Fill Color button arrow on 
the Ribbon.

• Click Orange, Accent 1 (column 5, 
row 1) on the Fill Color palette.

• Click the Font Color button arrow 
on the Ribbon and then select 
White, Background 1 (column 1, 
row 1) on the Font Color palette 
(Figure 3–42).

Fill Color 
button arrow 

fi ll color and font 
color of range 
A1:H2 changed Figure 3–42

Font Color 
button arrow

Heading 3 cell 
style applied 

Figure 3–43

font color and fi ll 
color changed 

Total cell 
style applied 

Other Ways

1. Right-click range, click 
Format Cells on shortcut 
menu, click Fill tab to 
color background (or 
click Font tab to color 
font), click OK button

2. Press CTRL+1, click Fill tab 
to color background (or 
click Font tab to color 
font), click OK button

The Fill and Font Color 
Button
You may have noticed 
that the color bar at the 
bottom of the Fill Color 
and Font Color buttons 
on the Home tab on the 
Ribbon (Figure 3-42) 
changes to the most 
recently selected color. 
To apply this same color 
to a cell background or 
text, select a cell and 
then click the Fill Color 
button to use the color as 
a background or click the 
Font Color button to use 
the color as a font color. 

B
T
W
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Copying a Cell’s Format Using the Format Painter Button   EX 201

Copying a Cell’s Format Using the Format 
Painter Button
Using the Format Painter button on the Ribbon, you can format a cell quickly by copying 
a cell’s format to another cell or a range of cells. 

To Copy a Cell’s Format Using the Format Painter Button

The following steps format cells A6, A14, and the range A16:H16 using the Format Painter button.

1
• Select cell A4.

• Click the Format Painter button 
on the Ribbon and then move the 
mouse pointer onto the worksheet 
to cause the mouse pointer to 
change to a block plus sign with a 
paintbrush (Figure 3–44). 

Format Painter 
button

marquee is 
displayed around 
cell A4 

Figure 3–44

cell A4 
selected

block plus sign 
with paint brush 
mouse pointer 
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2
• Click cell A6 to assign the format 

of cell A4 to cell A6 (Figure 3–45).

format of cell A4 
copied to cell A6 

Figure 3–45

3
• With cell A6 selected, click the 

Format Painter button on the 
Ribbon and then click cell A14.

• With cell A14 selected, click the 
Format Painter button on the 
Ribbon and then click cell A16.

• Select the range B16:H16, click the 
Fill Color button on the Ribbon, and 
then click the Orange, Accent 1 color 
(column 5, row 1) on the Fill Color 
palette.

• Click the Font Color button on 
the Ribbon, and then click the 
Background 1 color (column 1, 
row 1) on the Font Color palette 
(Figure 3–46).

• Apply the Currency style to the 
range B16:G16. 

Figure 3–46

format copied 
to cell A14 and 
range A16:H16

1. Click Copy button, select 
cell, click Paste button, click 
Paste Special command on 
Paste menu, click Formats, 
click OK button

2.  Double-click Format Painter 
button

Other Ways
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Copying a Cell’s Format Using the Format Painter Button   EX 203

To Format the What-If Assumptions Table and Save the Workbook

The last step to improving the appearance of the worksheet is to format the What-If 
Assumptions table in the range A18:B25. The specifi cations in Figure 3–35 on page EX 196 
require a 14-point italic underlined font for the title in cell A18 and 8-point font in the range 
A19:B25. The following steps format the What-If Assumptions table.

1  Scroll down to view rows 18 through 25 and then click cell A18.

2  Click the Font Size box arrow on the Ribbon and then click 14 in the Font Size list. Click the 
Italic button and then click the Underline button on the Ribbon. 

3  Select the range A19:B25, click the Font Size button on the Ribbon, and then click 8 in the 
Font Size list.

4  Click cell D25 to deselect the range A19:B25 and display the What-If Assumptions table as 
shown in Figure 3–47. 

5  Click the Save button on the Quick Access Toolbar.

What happens when I click the Italic and Underline buttons? 

Recall that when you assign the italic font style to a cell, Excel slants the characters slightly 
to the right as shown in cell A18 in Figure 3–47. The underline format underlines only the 
characters in the cell, rather than the entire cell, as is the case when you assign a cell a 
bottom border. 

Q
&

A

Italic button

Underline 
button

Figure 3–47

14-point italic 
underlined font 

8-point font

Painting a Format to 
Nonadjacent Ranges
Double-click the Format 
Painter button on the 
Home tab on the Ribbon 
and then drag through 
the nonadjacent ranges 
to paint the formats to 
the ranges. Click the 
Format Painter button to 
deactivate it. 

B
T
W
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Adding a 3-D Pie Chart to the Workbook
The next step in the chapter is to draw the 3-D Pie chart on a separate sheet in the 
workbook, as shown in Figure 3–48. Use a Pie chart to show the relationship or 
proportion of parts to a whole. Each slice (or wedge) of the pie shows what percent 
that slice contributes to the total (100%). 

Specify how the chart should convey necessary information.
The 3-D Pie chart in Figure 3–48 shows the contribution of each month’s projected operating 
income to the six-month projected operating income. The 3-D Pie chart makes it easy to 
evaluate the contribution of one month in comparison to the other months.

Unlike the 3-D Column chart created in Chapter 1, the 3-D Pie chart shown in Figure 3–48 
is not embedded in the worksheet. Instead, the Pie chart resides on a separate sheet, called 
a chart sheet, which contains only the chart.

In this worksheet, the ranges to chart are the nonadjacent ranges B3:G3 (month names) 
and B16:G16 (monthly operating incomes). The month names in the range B3:G3 will identify 
the slices of the Pie chart; these entries are called category names. The range B16:G16 contains 
the data that determines the size of the slices in the pie; these entries are called the data 
series. Because six months are being charted, the 3-D Pie chart contains six slices.

The sketch of the 3-D Pie chart in Figure 3–3b on page EX 166 also calls for emphasizing the 
month of June by offsetting its slice from the main portion. A Pie chart with one or more 
slices offset is called an exploded Pie chart.

Plan 
Ahead

As shown in Figure 3–48, the default 3-D Pie chart also has been enhanced by rotating 
it, changing the colors of the slices, adding a bevel, and modifying the chart title and labels that 
identify the slices.

exploded slice

default color of 
slices changed

chart title 
underlined and 
font size changed

Figure 3–48

data labels 
changed to 
month and 
percentage

3-D Pie chart

Charts
You are aware that, 
when you change a 
value on which a chart 
is dependent, Excel 
immediately redraws the 
chart based on the new 
value. Did you know 
that, with bar charts, you 
can drag the bar in the 
chart in one direction or 
another to change the 
corresponding value in 
the worksheet, as well? 

B
T
W

Certifi cation
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential – proof 
that you have the Excel 
2007 skills required by 
employers. For more 
information, see Appendix 
F or visit the Excel 2007 
Certifi cation Web page 
(scsite.com/ex2007/cert).

B
T
W

Chart Items
When you rest the 
mouse pointer over 
a chart item, such as 
a legend, bar, or axis, 
Excel displays a chart tip 
containing the name of 
the item. 

B
T
W
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Adding a 3-D Pie Chart to the Workbook   EX 205

To Draw a 3-D Pie Chart on a Separate Chart Sheet

The following steps draw the 3-D Pie chart on a separate chart sheet.

1
• Select the range B3:G3.

• While holding down the CTRL key, 
select the range B16:G16.

• Click the Insert tab on the Ribbon.

• Click the Pie button on the 
Ribbon to display the Pie gallery 
(Figure 3–49).

Insert tab 

Pie gallery

Figure 3–49

Pie button

Pie in 3-D chart

2

• Click Pie in 3-D chart in the 
Pie gallery.

• When Excel draws the chart, 
click the Move Chart button 
on the Ribbon to display 
the Move Chart dialog box 
(Figure 3–50).

Move Chart button

New sheet 
option button 

Move Chart 
dialog box 

Figure 3–50

New sheet name textbox

OK button
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3
• Click the New sheet option button 

and then type 3-D Pie Chart in 
the New sheet name textbox.

• Click the OK button to move the 
chart to a new chart sheet with the 
name 3-D Pie Chart (Figure 3–51).

Figure 3–51

new sheet 
created with 
new name 

Other Ways

1. Select range to chart, 
press F11

To Insert a Chart Title and Data Labels

The next step is to insert a chart title and labels that identify the slices. Before you can format a chart item, 
such as the chart title or data labels, you must select it. You can format a selected chart item using the Ribbon or 
shortcut menu. The following steps insert a chart title, remove the legend, and add data labels. 

1
• Click anywhere in the chart area 

outside the chart.

• Click the Layout tab on the Ribbon 
and then click the Chart Title button. 

• Click the Centered Overlay Title 
command in the Chart Title gallery. 

• Select the text in the chart 
title and then type Semiannual 
Financial Projection as the 
new chart title (Figure 3–52).

Layout tab 

chart title 

Figure 3–52
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Adding a 3-D Pie Chart to the Workbook   EX 207

2
• Select the text in the new title and 

then click the Home tab on the 
Ribbon.

• Click the Underline button to 
assign an underline font style to 
the chart title (Figure 3–53). 

Home tab 

chart title 
underlined

Figure 3–53

Underline button

3
• Click the Layout tab on the 

Ribbon and then click the 
Legend button to display 
the Legend gallery.

• Point to None in the Legend 
gallery (Figure 3–54). 

Layout tab

Legend gallery

Figure 3–54

None legend option

legend 
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4
• Click None to turn 

off the legend on 
the chart.

• Click the Data 
Labels button 
on the Ribbon 
and then click 
Outside End in 
the Data Labels 
gallery to display 
data labels outside 
the chart at the 
end of each slice 
(Figure 3–55). 

Data Labels button 

legend no longer 
is displayed 

Figure 3–55

data labels selected 

5
• If necessary, right-

click any data label 
to select all of the 
data labels on the 
chart and to display 
the shortcut menu.

• Click the Format 
Data Labels com-
mand on the short-
cut menu to display 
the Format Data 
Labels dialog box. 

• If necessary, click the 
Series Name, Value, 
and Show Leader 
Lines check boxes 
to deselect them 
and then click the 
Category Name and 
Percentage check 
boxes to select them 
(Figure 3–56). 

Value check box

Format 
Data Labels 
dialog box 

Figure 3–56

Percentage check box

Series Name check box

Category Name check box

Close button

Show Leader Lines 
check box
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Adding a 3-D Pie Chart to the Workbook   EX 209

6
• Click the Close 

button to close the 
Format Data Labels 
dialog box and 
display the chart 
as shown in 
Figure 3–57. 

chart selected

data labels 
include category 
name and 
percentage

Figure 3–57

To Rotate the 3-D Pie Chart

With a three-dimensional chart, you can change the view to better show the section of the chart you are trying 
to emphasize. Excel allows you to control the rotation angle, elevation, perspective, height, and angle of the axes by 
using the Format Chart Area dialog box.

When Excel initially draws a Pie chart, it always positions the chart so that one of the dividing lines between 
two slices is a straight line pointing to 12 o’clock (or 0°). As shown in Figure 3–57, the line that divides the January 
and June slices currently is set to 0°. This line defi nes the rotation angle of the 3-D Pie chart. 

To obtain a better view of the offset June slice, the 3-D Pie chart can be rotated 250° to the right. The following 
steps show how to rotate the 3-D Pie chart.
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1
• Click the 3-D Rotation 

button on the Ribbon 
to display the Format 
Chart Area dialog box.

• Click the Increase 
X Rotation button 
in the Rotation area 
of the Format Chart 
Area dialog box until 
the X rotation is at 
250° (Figure 3–58).

What happens as I 
click the Increase 
X Rotation button? 

Excel rotates the 
chart 10° in a 
clockwise direction 
each time you click 
the Increase 
X Rotation button. 
The Y box in the 
Rotation area allows 
you to control the 
tilt, or elevation, 
of the chart. You 
can tilt the chart 
towards or away from 
your view in order to enhance the view of the chart. 

Close button

3-D Rotation 
category

Rotation area

Format Chart 
Area dialog box

Figure 3–58

Increase X 
Rotation button

3-D Rotation 
button

chart rotated

Q
&

A

2
• Click the Close button 

in the Format Chart 
Area dialog box to 
display the rotated 
chart (Figure 3–59).

chart rotated to 
show June slice

Figure 3–59
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Adding a 3-D Pie Chart to the Workbook   EX 211

To Apply a 3-D Format to the Pie Chart

Excel allows you to apply dramatic 3-D visual effects to charts. The chart shown in Figure 3–59 could be enhanced 
with a bevel along the top edge. A bevel is a curve that is applied to soften the appearance of a straight edge. Excel also 
allows you to change the appearance of the material from which the surface of the chart appears to be constructed. The 
following steps apply a bevel to the chart and change the surface of the chart to a softer-looking material.

1
• Right-click the chart 

to display the shortcut 
menu (Figure 3–60).

Format Data 
Series command

shortcut menu

Figure 3–60

2
• Click the Format Data Series 

command on the shortcut menu 
to display the Format Data Series 
dialog box and then click the 3-D 
Format category on the left side of 
the dialog box.

• Click the Top button in the Bevel 
area to display the Bevel gallery 
(Figure 3–61).

Top bevel button

Format Data Series 
dialog box 

Figure 3–61

Circle bevel button

3-D Format category

Bevel gallery
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3
• Click the Circle bevel 

button (column 1, 
row 1) in the Bevel 
gallery to add a 
bevel to the chart. 

• Type 50 pt in the 
top Width box in the 
Bevel area of the 
dialog box and then 
type 50 pt in the 
uppermost Height 
box in the Bevel area 
of the dialog box to 
increase the width 
and height of the 
bevel on the chart 
(Figure 3–62).

Close button

Bevel added 
to chart

Figure 3–62

bevel width and 
height set to 50 pt 

4
• Click the Material 

button in the 
Surface area of the 
Format Data Series 
dialog box and 
then point to the 
Soft Edge button 
(column 2, row 2) in 
the Material gallery 
(Figure 3–63).

Material button

Soft Edge 
gallery selection

Surface area

Figure 3–63

Material gallery
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Adding a 3-D Pie Chart to the Workbook   EX 213

5
• Click the Soft Edge 

button and then 
click the Close 
button in the 
Format Data Series 
dialog box 
(Figure 3-64).

soft edge is 
displayed 
on chart 

Figure 3–64

To Explode the 3-D Pie Chart and Change the Color of a Slice

The next step is to emphasize the slice representing June by offsetting, or exploding, it from the rest of the 
slices so that it stands out. The following steps explode a slice of the 3-D Pie chart and then change its color.

1
• Click the slice labeled 

June twice (do not 
double-click) to select 
only the June slice.

• Right-click the slice 
labeled June to 
display the shortcut 
menu and then point 
to Format Data Point 
(Figure 3–65). 

• Click Format 
Data Point.

June slice selected

Format Data 
Point command 

shortcut menu 

Figure 3–65
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2
• When Excel 

displays the Format 
Data Point dialog 
box, drag the Point 
Explosion slider to 
the right until the 
Point Explosion 
box reads 28% 
(Figure 3–66).

Should I offset more 
slices? 

You can offset as 
many slices as you 
want, but remember 
that the reason for 
offsetting a slice 
is to emphasize 
it. Offsetting 
multiple slices tends 
to reduce the impact 
on the reader and 
reduces the overall 
size of the Pie chart. 

Point Explosion 
slider  

Format Data 
Point dialog box

Figure 3–66

June slice 
exploded 28%

Q
&

A

3
• Click the Fill category 

on the left side of the 
dialog box. 

• Click the Solid fi ll 
option button and 
then click the Color 
button to display 
the color palette.

• Point to the Orange 
color in the Standard 
Colors area 
(Figure 3–67).

4
• Click the Orange 

color on the color 
palette and then 
click the Close button 
on the Format Data 
Point dialog box to 
change the color of 
the slice labeled June 
to orange.

Fill category

Orange 
standard color 

Theme Colors 
palette 

Figure 3–67

Color button

Close button

Point Explosion 
box reads 28%

Solid fi ll option 
button
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To Change the Colors of the Remaining Slices

The colors of the remaining slices also can be changed to enhance the appeal of the 
chart. The following steps change the color of the remaining fi ves chart slices.

1  Click the slice labeled January twice (do not double-click) to select only the January slice.

2  Right-click the slice labeled January to display the shortcut menu and then point to Format 
Data Point. 

3  Click the Fill category on the left side of the dialog box. 

4  Click the Solid fi ll option button and then click the Color button to display the color palette.

5  Click the Green color on the color palette and then click the Close button in the Format 
Data Point dialog box to change the color of the slice labeled January to green.

6  Repeat steps 1 through 5 for the remaining four slices. Assign the following colors in the 
Standard Colors area of the color palette to each slice: February – Yellow; March – Light 
Blue; April – Red; May – Blue. The completed chart appears as shown in Figure 3–68.

Figure 3–68

slice colors 
changed 

Exploding a 
3-D Pie Chart
If you click the 3-D Pie 
chart so that all of the 
slices are selected, you can 
drag one of the slices to 
explode all of the slices. 
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Renaming and Reordering the Sheets and Coloring 
Their Tabs
The fi nal step in creating the workbook is to reorder the sheets and modify the tabs at the 
bottom of the screen. 

To Rename and Reorder the Sheets and Color Their Tabs

The following steps rename the sheets, color the tabs, and reorder the sheets so the worksheet precedes the 
chart sheet in the workbook.

1
• Right-click the tab labeled 3-D Pie 

Chart at the bottom of the screen 
to display the shortcut menu.

• Point to the Tab Color command 
to display the color palette 
(Figure 3–69).

Tab Color command

shortcut menu 

Figure 3–69

3-D Pie Chart tab 

desired color
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Renaming and Reordering the Sheets and Coloring Their Tabs   EX 217

3
• Click Orange, Accent 1 (column 5, 

row 1) in the Theme Colors area 
to change the color of the tab 
to orange.

• Drag the Semiannual Financial 
Projection tab to the left in 
front of the 3-D Pie Chart tab 
to rearrange the sequence of 
the sheets and then click 
cell E18 (Figure 3–71).

2
• Click Brown, Accent 2 (column 6, 

row 1) in the Theme Colors area 
to change the color of the tab 
to brown.

• Double-click the tab labeled 
Sheet1 at the bottom of 
the screen.

• Type Semiannual Financial 
Projection as the new sheet 
name and then press the 
ENTER key.

• Right-click the tab and then click 
Tab Color on the shortcut menu.

• Point to the Orange, Accent 1 
(column 5, row 1) color in the 
Theme Colors area of the palette 
(Figure 3–70).

Tab Color command

shortcut menu

Figure 3–70

sheet renamed

desired color 

3-D Pie Chart 
tab colored 
brown 

tab color shows 
as orange 
underline when 
sheet is active 

Figure 3–71

Sheet 1 renamed 
and moved to 
left of 3-D Pie 
Chart tab 

Other Ways

1. To rename sheet, 
right-click sheet tab, 
click Rename on 
shortcut menu

2.  To move sheet, 
right-click sheet tab, 
click Move or Copy 
on shortcut menu
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Checking Spelling, Saving, Previewing, and 
Printing the Workbook
With the workbook complete, this section checks spelling, saves, previews, and then prints 
the workbook. Each set of steps concludes with saving the workbook to ensure that the 
latest changes are saved.

To Check Spelling in Multiple Sheets

By default, the spell checker checks the spelling only in the selected sheets. It will 
check all the cells in the selected sheets, unless you select a range of two or more cells. 
Before checking the spelling, the following steps select the 3-D Pie Chart sheet so that 
the entire workbook is checked for spelling errors.

1  With the Semiannual Financial Projection sheet active, press CTRL+HOME to select cell A1. 
Hold down the CTRL key and then click the 3-D Pie Chart tab.

2  Click the Review tab on the Ribbon and then click the Spelling button on the Ribbon.

3  Correct any errors and then click the OK button when the spell check is complete.

4  Click the Save button on the Quick Access Toolbar.

To Preview and Print the Workbook 

After checking the spelling, the next step is to preview and print the sheets. As 
with spelling, Excel previews and prints only the selected sheets. In addition, because the 
worksheet is too wide to print in portrait orientation, the orientation must be changed to 
landscape. The following steps adjust the orientation and scale, preview the workbook, 
and then print the workbook.

1  Ready the printer. If both sheets are not selected, hold down the CTRL key and then click 
the tab of the inactive sheet.

2  Click the Page Layout tab on the Ribbon and then click the Page Setup Dialog Box 
Launcher. Click the Page tab and then click Landscape. Click Fit to in the Scaling area.

3  Click the Print Preview button in the Page Setup dialog box. When the preview of the fi rst 
of the selected sheets appears, click the Next Page button at the top of the Print Preview 
window to view the next sheet. Click the Previous Page button to redisplay the fi rst sheet.

4  Click the Print button at the top of the Print Preview window. When Excel displays the 
Print dialog box, click the OK button to print the worksheet and chart (Figure 3–72).

5  Right-click the Semiannual Financial Projection tab. Click Ungroup Sheets on the shortcut 
menu to deselect the 3-D Pie Chart tab.

6  Click the Save button on the Quick Access Toolbar.

Checking Spelling
Unless you fi rst select 
a range of cells or an 
object before starting the 
spell checker, Excel checks 
the selected worksheet, 
including all cell values, 
cell comments, embedded 
charts, text boxes, buttons, 
and headers and footers. 

B
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Printing in Black and 
White
You can speed up the 
printing process and 
save ink if you print 
worksheets with color in 
black and white. To print 
a worksheet in black and 
white on a color printer, 
do the following: (1) Click 
the Page Setup Dialog 
Box Launcher on the Page 
Layout tab on the Ribbon, 
click the Sheet tab, and 
then click ‘Black and white’ 
in the Print area. (2) Click 
the Preview button to 
see that Excel has removed 
the colored backgrounds, 
click the Close button, and 
then click the OK button. 
You are now ready to 
print economically, in 
black and white. 
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Quick Reference
For a table that lists how 
to complete the tasks 
covered in this book 
using the mouse, Ribbon, 
shortcut menu, and 
keyboard, see the Quick 
Reference Summary at 
the back of this book, or 
visit the Excel 2007 Quick 
Reference Web page 
(scsite.com/ex2007/qr). 
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Checking Spelling, Saving, Previewing, and Printing the Workbook   EX 219

Figure 3–72

(a) Worksheet

(b) 3-D Pie Chart

C6162_EXC_03.4c.indd   219C6162_EXC_03.4c.indd   219 3/6/07   3:33:34 PM3/6/07   3:33:34 PM



EX 220   Excel Chapter 3   What-If Analysis, Charting, and Working with Large Worksheets

Changing the View of the Worksheet
With Excel, you easily can change the view of the worksheet. For example, you can 
magnify or shrink the worksheet on the screen. You also can view different parts of the 
worksheet through window panes.

To Shrink and Magnify the View of a Worksheet or Chart

You can magnify (zoom in) or shrink (zoom out) the appearance of a worksheet or chart by using the Zoom 
button on the View tab on the Ribbon. When you magnify a worksheet, Excel enlarges the view of the characters on 
the screen, but displays fewer columns and rows. Alternatively, when you shrink a worksheet, Excel is able to display 
more columns and rows. Magnifying or shrinking a worksheet affects only the view; it does not change the window 
size or printout of the worksheet or chart. The following steps shrink and magnify the view of the worksheet.

1
• If cell A1 is not active, press 

CTRL+HOME.

• Click the View tab on the Ribbon 
and then click the Zoom button 
on the Ribbon to display a list 
of Magnifi cations in the Zoom 
dialog box (Figure 3–73).

View tab

Zoom 
dialog box

Fit selection 
option zooms 
window to 
selected range 

Figure 3–73

Zoom button

75% button 

OK button

Zooming
You can use the Zoom In 
and Zoom Out buttons 
on the status bar to zoom 
from 10% to 400% to 
reduce or enlarge the 
display of the worksheet.
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Changing the View of the Worksheet   EX 221

2
• Click 75% and then click the OK 

button to shrink the display of the 
worksheet to 75% of its normal 
display (Figure 3–74).

worksheet 
displays at 75%

Figure 3–74

3
• Click the Zoom In button on the 

status bar until the worksheet 
displays at 100% (Figure 3–75).

Zoom In button

worksheet 
displays at 100%

Figure 3–75
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To Split a Window into Panes

When working with a large worksheet, you can split the window into two or four panes to view different parts 
of the worksheet at the same time. Splitting the Excel window into four panes at cell D7 allows you to view all four 
corners of the worksheet easily. The following steps split the Excel window into four panes.

1
• Select cell D7, the intersection of 

the four proposed panes.

• If necessary, click the View tab 
on the Ribbon and then point to 
the Split button on the Ribbon 
(Figure 3–76).

Split button

panes will be 
divided above 
and to the left 
of active cell 

Figure 3–76
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What-If Analysis   EX 223

2
• Click the Split button to divide the 

window into four panes.

• Use the scroll arrows to show the 
four corners of the worksheet at 
the same time (Figure 3–77).

What is shown in the four panes?

The four panes in Figure 3–77 are 
used to show the following: 
(1) range A1:C6 in the 
upper-left pane; 
(2) range G1:I6 
in the upper-
right pane; 
(3) range A14:C26 
in the lower-left 
pane; and (4) range G14:I26 in 
the lower-right pane. The 
vertical split bar is the vertical bar 
going up and down the middle of 
the window. The horizontal split 
bar is the horizontal bar going 
across the middle of the window. 
If you use the scroll bars below 
the window and to the right of 
the window to scroll the window, 
you will see that the panes split by 
the horizontal split bar scroll together 
vertically. The panes split by the vertical split bar scroll together horizontally. To resize the 
panes, drag either split bar to the desired location in the window. 

vertical split bar

horizontal 
split bar 

right panes move 
in horizontal 
synchronization

upper panes 
move in vertical 
synchronization 

lower panes 
move in vertical 
synchronization

scroll bars 
for top and 
bottom panes 

left panes move 
in horizontal 
synchronization 

scroll bars 
for left and 
right panes

Figure 3–77

Q
&
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Other Ways

1. Drag horizontal split 
box and vertical split 
box to desired locations

To Remove the Panes from the Window

1  Position the mouse pointer at the intersection of the horizontal and vertical split bars.

2  When the mouse pointer changes to a four-headed arrow, double-click to remove the four 
panes from the window.

What-If Analysis
The automatic recalculation feature of Excel is a powerful tool that can be used to analyze 
worksheet data. Using Excel to scrutinize the impact of changing values in cells that are 
referenced by a formula in another cell is called what-if analysis or sensitivity analysis. 
When new data is entered, Excel not only recalculates all formulas in a worksheet, but 
also redraws any associated charts.

Window Panes
If you want to split the 
window into two panes, 
rather than four, drag the 
vertical split box to the 
far left of the window or 
horizontal split box to the 
top of the window (Figure 
3-78 on the next page). 
You also can drag the 
center of the four panes 
in any direction to change 
the size of the panes. 
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In the workbook created in this chapter, many of the formulas are dependent on 
the assumptions in the range B19:B25. Thus, if you change any of the assumption val-
ues, Excel immediately recalculates all formulas. Excel redraws the 3-D Pie chart as well, 
because it is based on these numbers.

To Analyze Data in a Worksheet by Changing Values

A what-if question for the worksheet in Chapter 3 might be what would happen to the semiannual operating 
income in cell H16 if the Bonus, Commission, Support, General, and Administrative assumptions in the What-If 
Assumptions table are changed as  follows: Bonus $100,000.00 to $75,000.00; Commission 3.25% to 2.25%; Support, 
General, and Administrative 17.00% to 14.50%? To answer a question like this, you need to change only the fi rst, 
second, and seventh values in the What-If Assumptions table as shown in the following steps. The steps also divide 
the window into two vertical panes. Excel instantaneously recalculates the formulas in the worksheet and redraws 
the 3-D Pie chart to answer the question.

1
• Use the vertical scroll bar to move 

the window so cell A6 is in the 
upper-left corner of the screen.

• Drag the vertical split box from 
the lower-right corner of the 
screen to the left so that the 
vertical split bar is positioned as 
shown in Figure 3-78.

• Use the right scroll arrow to view 
the totals in column H in the 
right pane.

• Enter 75000 in cell B19, 2.25 in 
cell B20, and 14.50 in cell B25 
(Figure 3–78), which causes the  
semiannual operating income 
in cell H16 to increase from 
$9,459,176.31 to $10,886,373.12.

vertical split bar 

horizontal 
split box 

current location 
of vertical 
split box 

Figure 3–78

new projected 
semiannual 
operating 
income

original location 
of vertical 
split box 

changes to assumptions affect 
projected monthly expenses and 
operating incomes, which in turn affect 
projected semiannual operating income 
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What-If Analysis   EX 225

To Goal Seek

If you know the result you want a formula to produce, you can use goal seeking to determine the value of 
a cell on which the formula depends. The following steps close and reopen the Campus Clothiers Semiannual 
Financial Projection workbook. They then show how to use the Goal Seek command on the Data tab on the Ribbon 
to determine the Support, General, and Administrative percentage in cell B25 that will yield a semi annual operat-
ing income of $10,500,000 in cell H16, rather than the original $9,459,176.31.

1
• Close the workbook 

without saving 
changes and then 
reopen it.

• Drag the vertical 
split box so that the 
vertical split bar is 
positioned as shown 
in Figure 3–79.

• Show column H in 
the right pane.

• Click cell H16, the 
cell that contains 
the semiannual 
operating income.

• Click the Data tab on 
the Ribbon and then 
click the What-If 
Analysis button on 
the Ribbon to display 
the What-If Analysis 
menu (Figure 3–79).

Data tab 

Goal Seek 
command 

What-If 
Analysis 
button 

vertical split bar

vertical split bar 
dragged to this 
location

Figure 3–79

What-If 
Analysis 
menu 

cell on which 
to seek goal
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2
• Click Goal Seek to 

display the Goal Seek 
dialog box with the 
Set cell box set to the 
selected cell, H16.

• When Excel displays 
the Goal Seek dialog 
box, click the To 
value text box, type 
10500000 and then 
click the By changing 
cell box.

• Scroll down so row 4 
is at the top of 
the screen.

• Click cell B25 on the 
worksheet to assign 
cell B25 to the By 
changing cell box 
(Figure 3–80).

OK button 

goal 

Goal Seek 
dialog box

Figure 3–80

active cell 

cell to change 
to reach goal

cell on which 
to seek goal is 
set based on 
active cell 
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What-If Analysis    EX 227

3
• Click the OK 

button to goal 
seek for the value 
$10,500,000.00 
in cell H16 
(Figure 3–81). 

What happens when 
I click the OK button? 

Excel immediately 
changes cell H16 
from $9,459,176.31
to the desired value 
of $10,500,000.00. 
More importantly, 
Excel changes the 
Support, General, 
and Administrative 
assumption in 
cell B25 from 
17.00% to 14.26% 
(Figure 3–81). Excel 
also displays the 
Goal Seek Status 
dialog box. If you 
click the OK button, 
Excel keeps the 
new values in the 
worksheet. If you 
click the Cancel 
button, Excel 
redisplays the 
original values. 

OK button 

Goal Seek Status 
dialog box

Support, General, 
and Administrative 
expenses changes from 
17.00% to 14.26% 

Figure 3–81

semiannual projected 
operating income changes 
from $9,459,176.31 to 
$10,500,000.00 

Q
&
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4
• Click the Cancel button in the Goal Seek Status dialog box.

Other Ways

1. Press ALT+T, G

Goal Seeking
Goal seeking assumes you can change the value of only one cell referenced 

directly or indirectly to reach a specific goal for a value in another cell. In this 
example, to change the semiannual operating income in cell H16 to $10,500,000.00, 
the Support, General, and Administrative percentage in cell B25 must decrease by 
2.74% from 17.00% to 14.26%.

You can see from this goal seeking example that the cell to change (cell B25) does 
not have to be referenced directly in the formula or function. For example, the semiannual 
operating income in cell H16 is calculated by the function =SUM(B16:G16). Cell B25 is 
not referenced in this function. Instead, cell B25 is referenced in the formulas in rows 9 
through 13, on which the monthly operating incomes in row 16 are based. Excel thus is 
capable of goal seeking on the semiannual operating income by varying the value for the 
Support, General, and Administrative assumption.

Cancel button 

Undoing What You Did
The Undo button is 
ideal for returning the 
worksheet to its original 
state after you have 
changed the values in a 
worksheet to answer a 
what-if question. To view 
the original worksheet 
after answering a what-if 
question, click the Undo 
button on the Quick 
Access Toolbar for each 
value you changed. 

B
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To Quit Excel

To quit Excel, complete the following steps.

1  Click the Close button on the title bar.

2  If the Microsoft Excel dialog box is displayed, click the No button.

Chapter Summary
In this chapter you learned how to work with large worksheets that extend beyond the window, how to use the fi ll 
handle to create a series, new formatting techniques, about the difference between absolute cell references and 
relative cell references, how to use the IF function, how to rotate text in a cell, freeze titles, change the magnifi cation 
of the worksheet, show different parts of the worksheet at the same time through multiple panes, create a 3-D Pie 
chart, and improve the appearance of a 3-D Pie chart. This chapter also introduced you to using Excel to do what-if 
analysis by changing values in cells and goal seeking. The items listed below include all the new Excel skills you have 
learned in this chapter.

 1. Rotate Text and Use the Fill Handle to Create a 
Series of Month Names (EX 169)

 2. Increase Column Widths and Enter Row Titles 
(EX 173)

 3. Copy a Range of Cells to a Nonadjacent Destination 
Area (EX 175)

 4. Insert a Row (EX 177)
 5. Enter Numbers with Format Symbols (EX 181)
 6. Freeze Column and Row Titles (EX 182)
 7. Enter and Format the System Date (EX 184)
 8. Enter a Formula Containing Absolute Cell 

References (EX 187)
 9. Enter an IF Function (EX 190)
 10. Copy Formulas with Absolute Cell References 

Using the Fill Handle (EX 192)
 11. Assign Formats to Nonadjacent Ranges (EX 196)
 12. Format the Worksheet Titles (EX 199)

 13. Copy a Cell’s Format Using the Format Painter 
Button (EX 201)

 14. Draw a 3-D Pie Chart on a Separate Chart Sheet 
(EX 205)

 15. Insert a Chart Title and Data Labels (EX 206)
 16. Rotate the 3-D Pie Chart (EX 209)
 17. Apply a 3-D Format to the Pie Chart (EX 211)
 18. Explode the 3-D Pie Chart and Change the Color 

of a Slice (EX 213)
 19. Rename and Reorder the Sheets and Color Their 

Tabs (EX 216)
 20. Shrink and Magnify the View of a Worksheet or 

Chart (EX 220)
 21. Split a Window into Panes (EX 222)
 22. Analyze Data in a Worksheet by Changing Values 

(EX 224)
 23. Goal Seek (EX 225)

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.
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Learn It Online

Learn It Online is a series of online student exercises that test your knowledge of chapter 
content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/off2007/learn. When the Offi ce 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test your 
knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 

Apply Your Knowledge

Reinforce the skills and apply the concepts you learned in this chapter.

Understanding Logical Tests and Absolute Cell Referencing
Instructions Part 1: Determine the truth value (true or false) of the following logical tests, given the 
following cell values: X4 = 25; Y3 = 28; K7 = 110; Z2 = 15; and Q9 = 35. Enter true or false.
 a. Y3 < X4    Truth value: 

 b. Q9 = K7    Truth value: 

 c. X4 + 15 * Z2 / 5 <> K7  Truth value: 

 d. K7 / Z2 > X4 � Y3   Truth value: 

 e. Q9 * 2 � 42 < (X4 + Y3 � 8) / 9 Truth value: 

 f. K7 + 300 <= X4 * Z2 + 10  Truth value: 

 g. Q9 + K7 > 2 * (Q9 + 25)  Truth value: 

 h. Y3 =  4 * (Q9 / 5)   Truth value: 

Instructions Part 2: Write cell K23 as a relative reference, absolute reference, mixed reference with the 
row varying, and mixed reference with the column varying.

            

Instructions Part 3: Start Excel. Open the workbook Apply 3-1 Absolute Cell References. See 
the inside back cover of this book for instructions for downloading the Data Files for Students, 
or see your instructor for information on accessing the files required in this book. You will 
recreate the numerical grid pictured in Figure 3–82.

Continued >
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Perform the following tasks:
 1. Enter a formula in cell C7 that multiplies cell C2 times the sum of cells C3 through C6. Write the 

formula so that when you copy it to cells D7 and E7, cell C2 remains absolute. Verify your formula 
by checking it with the values found in cells C7, D7, and E7 in Figure 3–82. 

 2. Enter a formula in cell F3 that multiplies cell B3 times the sum of cells C3 through E3. Write the 
formula so that when you copy the formula to cells F4, F5, and F6, cell B3 remains absolute. Verify 
your formula by checking it with the values found in cells F3, F4, F5, and F6 in Figure 3–82. 

 3. Enter a formula in cell C8 that multiplies cell C2 times the sum of cells C3 through C6. Write the 
formula so that when you copy the formula to cells D8 and E8, Excel adjusts all the cell references 
according to the destination cells. Verify your formula by checking it with the values found in 
cells C8, D8, and E8 in Figure 3–82.

 4. Enter a formula in cell G3 that multiplies cell B3 times the sum of cells C3, D3, and E3. Write the 
formula so that when you copy the formula to cells G4, G5, and G6, Excel adjusts all the cell 

   references according 
to the destination cells. 
Verify your formula by 
checking it with the 
values found in cells 
G3, G4, G5, and G6 in 
Figure 3–82.

 5.  Change the document 
properties, as specifi ed 
by your instructor. 
Change the worksheet 
header with your name, 
course number, and other 
information requested by 
your instructor. Save the 
workbook using the fi le 
name, Apply 3-1 Absolute 
Cell References Complete, 
and submit the revised 
workbook as requested by 
your instructor.

Figure 3–82

Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Nested IF Functions and More About the Fill Handle
Instructions Part 1: Start Excel. You will use nested IF functions to determine values for sets of data.

Perform the following tasks:
 1. Enter the following IF function in cell C1: 

 =IF(B1=“CA”,“West”, IF(B1=“NJ”,“East”, IF(B1=“IL”,“Midwest”,“State Error”))) 

Apply Your Knowledge continued
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Extend Your Knowledge   EX 231

 2. Use the fi ll handle to copy the nested IF function down through cell C7. Enter the following data 
in the cells in the range B1:B7 and then write down the results that display in cells C1 through C7 
for each set. Set 1: B1 = CA; B2 = NY; B3 = NJ; B4 = MI; B5 = IL; B6 = CA; B7 = IL. Set 2: B1= WI; 
B2 = NJ; B3 = IL; B4 = CA; B5 = NJ; B6 = NY; B7 = CA.

Set 1 Results: 

Set 2 Results: 
Instructions Part 2: Start Excel. Open the workbook Extend 3-1 Create Series. See the inside back 
cover of this book for instructions for downloading the Data Files for Students, or see your instructor 
for information on accessing the fi les required in this book. 

Perform the following tasks:
 1. Use the fi ll handle on one column at a time to propagate the fourteen series through row 16 as shown 

in Figure 3–83. For example, in column A, select cell A2 and drag the fi ll handle down to cell A16. 
In column C, hold down the CTRL key to repeat Monday through cell C16. In column D, select 
the range D2:D3 and drag the fi ll handle down to cell D16. Likewise, in columns F and I through K, 
select the two adjacent cells in rows 2 and 3 before dragging the fi ll handle down to the corresponding 
cell in row 16. 

 2. Select cell D21. While holding down the CTRL key, one at a time drag the fi ll handle three cells 
to the right, to the left, up, and down to generate four series of numbers beginning with zero and 
incremented by one.

 3. Select cell I21. Point to the cell border so that the mouse pointer changes to a plus sign with four 
arrows. Drag the mouse pointer down to cell I22 to move the contents of cell I21 to cell I22.

 4. Select cell I22. Point to the cell border so that the mouse pointer changes to a plus sign with four 
arrows. While 
holding down 
the CTRL key, 
drag the mouse 
pointer to cell 
M22 to copy the 
contents of cell 
I22 to cell M22.

 5. Select cell M21. 
Drag the fi ll 
handle in to the 
center of cell 
M21 so that the 
cell is shaded in 
order to delete 
the cell contents. 

 6. Change the 
document 
properties, as 
specifi ed by 
your instructor. 
Change the 
worksheet header 
with your name, 
course number, and other information requested by your instructor. Save the workbook using the 
fi le name, Extend 3-1 Create Series Complete, and submit the revised workbook as requested by 
your instructor.

Figure 3–83
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Make It Right

Analyze a workbook and correct all errors and/or improve the design.

Inserting Rows, Moving a Range, and Correcting Formulas in a Worksheet
Instructions: Start Excel. Open the workbook Make It Right 3-1 e-MusicPro.com Annual Projected 
Net Income. See the inside back cover of this book for instructions for downloading the Data Files for 
Students, or see your instructor for information on accessing the fi les required for this book. Correct 
the following design and formula problems (Figure 3–84a) in the worksheet.

(a) Before

(b) After

Figure 3–84

 1. The Royalty in cell C3 is computed using the formula =B9*B3 (Royalties % � Sales). Similar 
formulas are used in cells C4 and C5. The formula in cell C3 was entered and copied to cells C4 
and C5. Although the result in cell C3 is correct, the results in cells C4 and C5 are incorrect. 
Edit the formula in cell C3 by changing cell B9 to an absolute cell reference. Copy the corrected 
formula in cell C3 to cells C4 and C5. After completing the copy, click the Auto Fill Options 
button arrow that displays below and to the right of cell C5 and choose Fill Without Formatting. 

 2. The Royalty Bonus amounts in cells D3, D4, and D5 are computed using the IF function. The 
Royalty Bonus should equal the amount in cell B10 ($50,000) if the corresponding Sales in 
column B is greater than or equal to $2,750,000. If the corresponding Sales in column B is less 
than $2,750,000, then the Royalty Bonus is zero ($0). The IF function in cell D3 was entered and 
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In the Lab   EX 233

copied to cells D4 and D5. The current IF functions in cells D3, D4, and D5 are incorrect. Edit 
and correct the IF function in cell D3. Copy the corrected formula in cell D3 to cells D4 and D5. 
After completing the copy, click the Auto Fill Options button arrow that displays below and to the 
right of cell D5 and choose Fill Without Formatting.

 3. The Manufacturing Costs in cell E3 is computed using the formula =B11*B3 (Manu. Costs % x 
Sales). The formula in cell E3 was entered and copied to cells E4 and E5. Although the result in 
cell E3 is correct, the results in cells E4 and E5 are incorrect. Edit and correct the formula in cell 
E3 by changing cell B11 to an absolute cell reference. Copy the corrected formula in cell E3 to 
cells E4 and E5. After completing the copy, click the Auto Fill Options button arrow that displays 
below and to the right of cell E5 and choose Fill Without Formatting.

 4. Change the design of the worksheet by moving the Assumptions table in the range A8:B11 to 
the range A1:B4 as shown in Figure 3–84b. To complete the move, insert fi ve rows above row 1 
and then drag the Assumptions table to the range A1:B4. Use Figure 3–84b to verify that Excel 
automatically adjusted the cell references based on the move. Use the Undo button and Redo 
button on the Quick Access Toolbar to move the Assumptions table back and forth while the 
results of the formulas remain the same. 

 5. Change the document properties, as specifi ed by your instructor. Change the worksheet header 
with your name, course number, and other information requested by your instructor. Save the 
workbook using the fi le name, Make It Right 3-1 e-MusicPro.com Annual Projected Net Income 
Complete, and submit the revised workbook as requested by your instructor.

In the Lab

Create a workbook using the guidelines, concepts, and skills presented in this chapter. Labs 
are listed in order of increasing diffi culty.

Lab 1: Eight-Year Financial Projection
Problem: Your supervisor in the Finance department at Salioto Auto Parts has asked you to create 
a worksheet that will project the annual gross margin, expenses, total expenses, operating income, 
income taxes, and net income for the next ten years based on the assumptions in Table 3–9. The desired 
worksheet is shown in Figure 3–85. In Part 1 you will create the worksheet. In Part 2 you will create 
a chart to present the data, shown in Figure 3–86. In part 3 you will use Goal Seek to analyze three 
different sales scenarios.  

Table 3–9 Salioto Auto Parts Financial Projection Assumptions

Units Sold in Prior Year 11,459,713

Unit Cost $13.40

Annual Sales Growth 4.50%

Annual Price Decrease 4.25%

Margin 39.25%

Continued >
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Instructions Part 1: 
 1. Start Excel. Apply the Apex theme to the worksheet by using the Themes button on the Page 

Layout tab on the Ribbon. Bold the entire worksheet by selecting the entire worksheet and using 
the Bold button on the Home tab on the Ribbon.

 2. Enter the worksheet title Salioto Auto Parts in cell A8 and the subtitle Eight-Year Financial 
Projection in cell A9. Format the worksheet title in cell A8 to 36-point Algerian (or a similar font). 
Format the worksheet subtitle in cell A9 to 20-point Rockwell (or a similar font). Enter the system 
date in cell F9 using the NOW function. Format the date to the 14-Mar-01 style.

 3. Change the following column widths: A = 25.00 characters; B through I = 15.00 characters. 
Change the heights of rows 7, 10, and 21 to 42.00 points.

 4. Enter the eight column titles Year 1 through Year 8 in the range B10:I10 by entering Year 1 in 
cell B10 and then dragging cell B10’s fi ll handle through the range C10:I10. Format cell B10 as 
follows: (a) increase the font size to 14; (b) center and italicize; and (c) rotate its contents 45°. Use 
the Format Painter button to copy the format assigned to cell B10 to the range C10:I10.

 5. Enter the row titles in the range A11:A24. Change the font in cells A14, A20, A22, and A24 to 14-point 
Rockwell (or a similar font). Add thick bottom borders to the ranges B10:I10 and B12:I12.

 6. Enter the table title Assumptions in cell A1. Enter the assumptions in Table 3-9 in the range A2:B6. 
Use format symbols when entering the numbers. Change the font size of the table title to 14-point 
Rockwell and underline it.

 7. Select the range B11:I24 and then click the Format Cells: Number Dialog Box Launcher on the 
Home tab on the Ribbon to display the Format Cells dialog box. Use the Number category in the 
Format Cells dialog box to assign the Comma style with no decimal places and negative numbers 
enclosed in parentheses to the range B11:I24.

Figure 3–85

In the Lab continued
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In the Lab   EX 235

 8. Complete the following entries:

  a.  Year 1 Sales (cell B11) = Units Sold in Prior Year * (Unit Cost / (1 � Margin)) or =B2 * (B3 / (1 � B6))
  b.  Year 2 Sales (cell C11) = Year 1 Sales * (1 + Annual Sales Growth) * (1 � Annual Price Decrease) 

or =B11 * (1 + $B$4) * (1 � $B$5)
  c. Copy cell C11 to the range D11:I11.
  d. Year 1 Cost of Goods (cell B12) = Year 1 Sales � (Year 1 Sales * Margin) or =B11 * (1 � $B$6)
  e. Copy cell B12 to the range C12:I12.
  f. Gross Margin (cell B13) = Year 1 Sales � Year 1 Cost of Goods or =B11 � B12
  g. Copy cell B13 to the range C13:I13.
  h. Year 1 Advertising (cell B15) = 500 + 13% * Year 1 Sales or =500 + 13% * B11
  i. Copy cell B15 to the range C15:I15.
  j.  Maintenance (row 16): Year 1 = 1,905,000; Year 2 = 5,550,000; Year 3 = 4,250,000; Year 4 = 

5,050,000; Year 5 = 2,500,000; Year 6 = 3,150,000; Year 7 = 2,945,000; and Year 8 = 3,560.000.
  k. Year 1 Rent (cell B17) = 1,700,000
  l. Year 2 Rent (cell C17) = Year 1 Rent + 10% * Year 1 Rent or =B17 * (1 + 10%)
  m. Copy cell C17 to the range D17:I17.
  n. Year 1 Salaries (cell B18) = 22.25% * Year 1 Sales or =22.25% * B11
  o. Copy cell B18 to the range C18:I18.
  p. Year 1 Supplies (cell B19) = 1.5% * Year 1 Sales or =1.5% * B11
  q. Copy cell B19 to the range C19:I19.
  r. Year 1 Total Expenses (cell B20) or =SUM(B15:B19)
  s. Copy cell B20 to the range C20:I20.
  t.  Year 1 Operating Income (cell B22) = Year 1 Gross Margin � Year 1 Total Expenses or =B13 � B20
  u. Copy cell B22 to the range C22:I22.
  v.  Year 1 Income Taxes (cell B23): If Year 1 Operating Income is less than 0, then Year 1 Income 

Taxes equal 0; otherwise Year 1 Income Taxes equal 40% * Year 1 Operating Income or 
=IF(B22 < 0, 0, 40% * B22)

  w. Copy cell B23 to the range C23:I23.
  x. Year 1 Net Income (cell B24) = Year 1 Operating Income � Year 1 Income Taxes or =B22 � B23
  y. Copy cell B24 to the range C24:I24.

 9. Change the background colors as shown in Figure 3-85. Use orange (column 3 under Standard 
Colors) for the background colors.

 10. Zoom to: (a) 200%; (b) 75%; (c) 25%; and (d) 100%.

 11. Change the document properties, as specifi ed by your instructor.  Change the worksheet header 
with your name, course number, and other information requested by your instructor. Save the 
workbook using the fi le name, Lab3-1 Salioto Auto Parts Eight-Year Financial Projection.

 12. Preview the worksheet. Use the Page Setup button to fi t the printout on one page in landscape 
orientation. Preview the formulas version (CTRL+`) of the worksheet in landscape orientation using 
the Fit to option. Press CTRL+` to instruct Excel to display the values version of the worksheet. 
Save the workbook again and close the workbook.

 13. Submit the workbook as requested by your instructor.

Instructions Part 2: 
 1. Start Excel. Open the workbook Lab 3-1 Salioto Auto Parts Eight-Year Financial Projection. 

 2. Use the nonadjacent ranges B10:I10 and B24:I24 to create a 3-D Cylinder chart. Draw the chart 
by clicking the Column button on the Insert tab on the Ribbon. When the Column gallery is 
displayed, click the Clustered Cylinder chart type (column 1, row 3). When the chart is displayed, 
click the Move Chart button on the Ribbon to move the chart to a new sheet. 

Continued >
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In the Lab continued

 3. Select the legend on the right side of the chart and delete it. Add the chart title by clicking the 
Layout tab on the Ribbon, then clicking the Chart Title button. Click Above Chart in the Chart 
Title gallery. Format the chart title as shown in Figure 3–86. 

 4. To change the color of the cylinders, click one of the cylinders and use the Shape Fill button on 
the Format tab on the Ribbon. To change the color of the wall, click the wall behind the cylinders 
and use the Shape Fill button on the Format tab on the Ribbon. Use the same procedure to change 
the color of the base of the wall. 

 5. Rename the sheet tabs Eight-Year Financial Projection and 3-D Cylinder Chart. Rearrange the 
sheets so that the worksheet is leftmost, and color their tabs as shown in Figure 3–86. 

 6. Click the Eight-Year Financial Projection tab to display the worksheet. Save the workbook using 
the same fi le name (Lab 3-1 Salioto Auto Parts Eight-Year Financial Projection) as defi ned in 
Part 1. Submit the workbook as requested by your instructor.

Figure 3–86
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In the Lab   EX 237

Instructions Part 3: 
 1. Start Excel. Open the workbook Lab 3-1 Salioto Auto Parts Eight-Year Financial Projection. 

Divide the window into two panes by dragging the horizontal split box between rows 6 and 7. 
Use the scroll bars to show both the top and bottom of the worksheet. Using the numbers in 
columns 2 and 3 of Table 3-10, analyze the effect of changing the annual sales growth (cell B4) 
and annual price decrease (cell B5) on the net incomes in row 24. The resulting answers are in 
column 4 of Table 3–10. Submit the workbook or results of the what-if analysis for each case as 
requested by your instructor.

Table 3–10 Salioto Auto Parts Data to Analyze and Results

Case Annual Sales Growth Annual Price Decrease Year 8 Resulting Net Income 
                in Cell I24

1 7.45% 5.25% 174,568

2 12.75% �3.00% 6,677,903

3 �7.25% 1.65% (3,552,156)

 2. Close the workbook without saving it, and then reopen it. Use the What-If Analysis button on the 
Data tab on the Ribbon to goal seek. Determine a margin (cell B6) that would result in a Year 8 net 
income of $2,000,000 (cell I24). You should end up with a margin of 40.68% in cell B6. Submit the 
workbook with the new values or the results of the goal seek as requested by your instructor. Do 
not save the workbook with the latest changes.

In the Lab

Lab 2: Modifying a Weekly Payroll Worksheet
Problem: As a summer intern at Britney’s Music Emporium, you have been asked to modify the weekly 
payroll report shown in Figure 3–87a. The workbook, Lab 3-2 Britney’s Music Emporium Weekly 
Payroll Report, is included with the Data Files for Students. See the inside back cover of this book for 
instructions for downloading the Data Files for Students, or see your instructor for information on 
accessing the fi les required for this book.

The major modifi cations to the payroll report to be made in this exercise include: (1) reformatting 
the worksheet; (2) adding computations of time-and-a-half for hours worked greater than 40; 
(3) adding calculations to charge no federal tax in certain situations; (4) adding Social Security and 
Medicare deductions; (5) adding and deleting employees; and (6) changing employee information. The 
fi nal payroll report is shown in Figure 3–87b.
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(a) Before

Figure 3–87

(b) After

Instructions Part 1: 
 1. Start Excel. Open the workbook, Lab 3-2 Britney’s Music Emporium Weekly Payroll Report. 

 2. Select the worksheet by clicking the Select All button. Click the Clear button on the Home tab 
on the Ribbon and then click Clear Formats on the Clear menu to clear the formatting. Bold the 
entire worksheet.

 3. Delete rows 11 through 13 to remove the statistics below the Totals row. Change all the row 
heights back to the default height (12.75).

 4. Insert four rows above row 1 by selecting rows 1 through 4, right-clicking the selection, and 
clicking Insert on the shortcut menu.

 5. Change the row heights as follows: row 5 = 48.00; rows 6 and 7 = 25.50. One at a time, select cells 
D7, E7, and G7. For each cell, press the F2 key and then the ENTER key to display the column 
headings on multiple rows. Center the range B7:J7.
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Continued >
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 6. Delete column B by right-clicking the column heading and clicking Delete on the shortcut menu. 

 7. Insert a new column between columns C and D. Change the column widths as follows: A = 25.00; 
D = 13.00; and E through K = 9.71. Enter the new column D title YTD Soc. Sec. in cell D7.

 8. Insert two new columns between columns F and G. Enter the new column G title Soc. Sec. in 
cell G7. Enter the new column H title Medicare in cell H7.

 9. Enhance the worksheet title in cell A5 by using a 36-point light blue Arial Rounded MT Bold (or a 
similar font) font style as shown in Figure 3–87b.

 10. Assign the NOW function to cell B6 and format it to the 3/14/2001 style.

 11. Delete employee James, Delmar (row 12). Change Raul Aquire’s (row 8) hours worked to 2.5. 
Change Casimir Kwasny’s (row 9) number of dependents to 7 and rate per hour to $8.25. Change 
Tepin Ruiz’s (row 11) hours worked to 49.5 and Fred Holkavich’s (row 12) hours worked to 57.

 12. Freeze column A and rows 1 through 7 by selecting cell B8, clicking the Freeze Panes button on 
the View tab on the Ribbon, and then clicking Freeze Panes on the Freeze Panes menu. 

 13. In column D, enter the 
YTD Soc. Sec. values listed 
in Table 3–11.

 14. Insert two new rows 
immediately above the 
Totals row. Add the new 
employee data as listed in 
Table 3–12.

Table 3–11 The Britney Music Emporium’s YTD Social Security Values

Employee YTD Soc. Sec.

Aquire, Raul 767.00

Kwasny, Casimir 1307.75

Mohammed, Aadil  930.25

Ruiz, Tepin 7458.75

Holkavich, Fred  7457.75

Table 3–12 The Britney Music Emporium’s New Employee Data

Employee Dependents Rate per Hour YTD Soc. Sec. Hours Worked

Jordan, Leon 4 13.50 2952.78 37.25

Wright, Louis 5 23.25 7430.00 46.75

 15. Center the range B6:B14. Use the Currency category in the Format Cells dialog box to assign a 
Comma style (no dollar signs) with two decimal places and negative numbers within parentheses to 
the range C8:K15. Assign a Percent style and two decimal places to the range L8:L15. Draw a thick 
bottom border in the ranges A7:L7 and A14:L14.

 16. As shown in Figure 3–87b, enter and format the Social Security (7.65% with a maximum of 
$7,458.75) and Medicare tax (1.45%) information in the range A1:B3. Use format symbols where 
applicable.

 17. Change the formulas to determine the gross pay in column F and the federal tax in column I as 
follows:

  a.  In cell F8, enter an IF function that applies the following logic and then copy it to the range 
F9:F14. If Hours Worked <= 40, then Rate per Hour * Hours Worked, otherwise 
Rate per Hour * Hours Worked + 0.5 * Rate per Hour * (Hours Worked � 40) or =IF(E8 <= 40, 
C8 * E8, C8 * E8 + 0.5 * C8 *(E8 � 40))

  b.  In cell I8, enter the IF function that applies the following logic and then copy it to the range 
I9:I14. If (Gross Pay – Dependents * 22.09 > 0, then 20% * (Gross Pay – Dependents * 22.09), 
otherwise 0 or =IF(F8 – B8 * 22.09 > 0, 20% * (F8 – B8 * 22.09), 0)
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In the Lab continued

 18. An employee pays Social Security tax only if his or her YTD Soc. Sec. in column D is less than the 
Maximum Social Security value in cell B3. Use the following logic to determine the Social Security 
tax for Raul Aquire in cell G8 and then copy it to the range G9:G14.

  Soc. Sec. (cell G8): If Social Security Tax * Gross Pay + YTD Soc. Sec. > Maximum Social 
Security, then Maximum Social Security � YTD Soc. Sec., otherwise Social Security Tax * Gross 
Pay or =IF($B$1 * F8 + D8 >= $B$3, $B$3 � D8, $B$1 * F8)

 19. In cell H8, enter the following formula and then copy it to the range H9:H14:

  Medicare (cell H8) = Medicare Tax * Gross Pay or =$B$2 * F8

 20. In cell K8, enter the following formula and copy it to the range K9:K14:

  Net Pay (K8) = Gross Pay � (Soc. Sec. + Medicare + Federal Tax + State Tax) or =F8 � (G8 + H8 + 
I8 + J8)

 21. In cell L8, enter the following formula and copy it to the range L9:L14:

 % Taxes (cell L8) = (Soc. Sec. + Medicare + Federal Tax + State Tax) / Gross Pay or = (G8 + H8 + 
I8 + J8) / F8

 22. Use the Range Finder (double-click cell) to verify the new totals as shown in row 15 in Figure 3-87b. 
Unfreeze the worksheet by clicking the Freeze Panes button on the View tab on the Ribbon, and 
then clicking Unfreeze Panes on the Freeze Panes menu. 

 23. Preview the worksheet. Use the Page Setup button to change the orientation to landscape and fi t 
the report on one page.

 24. Change the document properties, as specifi ed by your instructor.  Change the worksheet header 
with your name, course number, and other information requested by your instructor. Save 
the workbook using the fi le name Lab 3-2 Britney’s Music Emporium Weekly Payroll Report 
Complete.

 25. Use the Zoom button on the View tab on the Ribbon to change the view of the worksheet. One by 
one, select all the percents on the Zoom dialog box. When you are done, return the worksheet to 
100% magnifi cation.

 26. Preview the formulas version (CTRL+`) in landscape orientation. Close the worksheet without 
saving the latest changes.

 27. Submit the workbook as requested by your instructor.

Instructions Part 2: Start Excel. Open Lab 3-2 Britney’s Music Emporium Weekly Payroll Report 
Complete. Using the numbers in Table 3–13, analyze the effect of changing the Medicare tax in cell B2. 
The fi rst case should result in a total Medicare tax in cell H15 of $106.78. The second case should 
result in a total Medicare tax of 
$166.73. Close the workbook without 
saving changes. Submit the results of 
the what-if analysis as requested by 
your instructor.

Instructions Part 3: Submit results for 
this part as requested by your instructor.
 1. Start Excel. Open Lab 3-2 Britney’s Music Emporium Weekly Payroll Report Complete. Select 

cell F8. Write down the formula that Excel displays in the formula bar. Select the range C8:C14. 
Point to the border surrounding the range and drag the selection to the range D17:D23. Click 
cell F8, and write down the formula that Excel displays in the formula bar below the one you wrote 
down earlier. Compare the two formulas. What can you conclude about how Excel responds when 
you move cells involved in a formula? Click the Undo button on the Quick Access Toolbar.

Table 3–13 The Britney Music Emporium’s Medicare Tax Cases

Case Medicare Tax 

1 2.85%

2 4.45%
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Continued >

 2. Right-click the range C8:C14 and then click Delete on the shortcut menu. When Excel displays 
the Delete dialog box, click Shift cells left and then click the OK button. What does Excel display 
in cell F8? Click cell F8 and then point to the Trace Error button that is displayed to the left of 
the cell. Write down the ScreenTip that is displayed. Click the Undo button on the Quick Access 
Toolbar.

 3. Right-click the range C8:C14 and then click Insert on the shortcut menu. When Excel displays 
the Insert dialog box, click Shift cells right and then click the OK button. What does Excel display 
in the formula bar when you click cell F8? What does Excel display in the formula bar when you 
click cell G8? What can you conclude about how Excel responds when you insert cells next to cells 
involved in a formula? Close the workbook without saving the changes.

In the Lab

Lab 3: Analysis of Indirect Expense Allocations
Problem: Your classmate works part time as a consultant for RockieView Resort and Spa. She has asked 
you to assist her in creating an indirect expense allocation worksheet (Figure 3–88) that will help the resort 
and spa administration better evaluate the profi t centers described in Table 3–14 on the next page.

Figure 3–88
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In the Lab continued

Instructions Part 1: Do the following to create the worksheet shown in Figure 3–88.
 1. Apply the Solstice theme to the worksheet. Bold the entire worksheet by selecting the entire 

worksheet and using the Bold button on the Ribbon.

 2. Change the following column widths: A = 28.00; B through I = 13.00; J = 14.00. 

 3. Enter the worksheet titles in cells A1 and A2 and the system date in cell J2. Format the date to the 
14-Mar-01 style.

 4. Enter the column titles, row titles, and the fi rst three rows of numbers in Table 3–14 in rows 3 
through 6. Center and italicize the column headings in the range B3:J3. Add a thick bottom border 
to the range B3:J3. Sum the individual rows 4, 5, and 6 in the range J4:J6. 

 5. Enter the Square Footage row in Table 3–14 with the comma format symbol in row 16. Sum row 
16 in cell J16. Use the Format Painter button to format cell J16. Change the height of row 16 to 
39.00. Vertically center the range A16:J16 through the use of the Format Cells dialog box.

 6. Enter the remaining row titles in the range A7:A17 as shown in Figure 3–88. Increase the font size 
in cells A7, A14, and A15 to 16-point.

 7. Copy the row titles in range A8:A13 to the range A18:A23. Enter the numbers shown in the range 
B18:B23 of Figure 3–88 with format symbols.

 8. The planned indirect expenses in the range B18:B23 are to be prorated across the profi t center as 
follows: Administrative (row 8), Energy (row 10), and Marketing (row 13) on the basis of Total Net 
Revenue (row 4); Depreciation (row 9), Insurance (row 11), and Maintenance (row 12) on the basis 
of Square Footage (row 16). Use the following formulas to accomplish the prorating:

  a.  Banquet Room Administrative (cell B8) = Administrative Expenses * Banquet Room Total Net 
Revenue / Resort Total Net Revenue or =$B$18 * B4 / $J$4

  b.  Banquet Room Depreciation (cell B9) = Depreciation Expenses * Banquet Room Square 
Footage / Total Square  Footage or =$B$19 * B16 / $J$16

  c.  Banquet Room Energy (cell B10) = Energy Expenses * Banquet Room Total Net Revenue / 
Resort Total Net Revenue or =$B$20 * B4 / $J$4

  d.  Banquet Room Insurance (cell B11) = Insurance Expenses * Banquet Room Square Feet / Total 
Square Footage or =$B$21 * B16 / $J$16

  e.  Banquet Room Maintenance (cell B12) = Maintenance Expenses * Banquet Room Square 
Footage / Total Square Footage or =$B$22 * B16 / $J$16

  f.  Banquet Room Marketing (cell B13) = Marketing Expenses * Banquet Room Total Net 
Revenue / Resort Total Net Revenue or =$B$23 * B4 / $J$4

  g.  Banquet Room Total Indirect Expenses (cell B14) = SUM(B8:B13)

  h.  Banquet Room Net Income (cell B15) = Total Net Revenue � (Cost of Sales + Direct 
Expenses + Total Indirect Expenses) or =B4 � (B5 + B6 + B14)

  i. Copy the range B8:B15 to the range C8:I15.

  j. Sum the individual rows 8 through 15 in the range J8:J15. 

Table 3–14 RockieView Resort and Spa Worksheet Data 

Banquet 
Room

Business 
Center

Children’s 
Game Room

Conference 
Rooms

Gift 
Shop

Lounge Restaurant Spa

Total Net Revenue 345819 192190 52750 212300 112100 622350 615350 92900

Cost of Sales 19750 16235 12900 55250 42100 115400 175000 42150

Direct Expenses 9245 9245 7250 19300 37400 101000 115600 24800

Square Footage 10500 875 1425 6250 1325 7500 6700 2750
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 9. Add a thick bottom border to the range B13:J13. Assign the Currency style with two decimal places 
and show negative numbers in parentheses to the following ranges: B4:J4; B8:J8; and B14:J15. 
Assign the Comma style with two decimal places and show negative numbers in parentheses to the 
following ranges: B5:J6 and B9:J13.

 10. Change the font in cell A1 to 48-point Britannic Bold (or a similar font). Change the font in 
cell A2 to 22-point Britannic Bold (or a similar font). Change the font in cell A17 to 18-point italic 
Britannic Bold.

 11. Use the background color blue and the font color white for the ranges A1:J2; A7; A15:J15; and 
A17:B23 as shown in Figure 3–88. 

 12. Rename the Sheet1 sheet, Analysis of Indirect Expenses, and color its tab blue.

 13. Update the document properties with your name, course number, and name for the workbook. 
Change the worksheet header with your name, course number, and other information requested 
by your instructor. Save the workbook using the fi le name, Lab 3-3 RockieView Resort and Spa 
Indirect Expenses Allocations.

 14. Preview the worksheet. Use the Page Setup button to change the orientation to landscape and 
fi t the report on one page. Preview the formulas version (CTRL+`) of the worksheet in landscape 
orientation using the Fit to option button in the Page Setup dialog box. Press CTRL+` to show the 
values version of the worksheet. Save the workbook again.

 15. Divide the window into four panes and show the four corners of the worksheet. Remove the four panes.  
Close the workbook but do not save the workbook.

Instructions Part 2: Start Excel. Open Lab 3-3 RockieView Resort and Spa Indirect Expenses 
Allocations. Draw a 3-D Pie chart (Figure 3–89) on a separate sheet that shows the contribution 
of each category of indirect expense to the total indirect expenses. That is, chart the nonadjacent 
ranges A8:A13 (category names) and J8:J13 (data series). Show labels that include category names and 
percentages. Do not 
show the legend or 
leader lines. Format 
the 3-D Pie chart as 
shown in Figure 3–89. 
Rename the chart 
sheet 3-D Pie Chart 
and color the tab red. 
Move the chart tab 
to the right of the 
worksheet tab. Save 
the workbook using 
the fi le name, Lab 3-3 
RockieView Resort 
and Spa Indirect 
Expenses Allocations. 
Submit the workbook 
as requested by your 
instructor.

Figure 3–89
Continued >
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In the Lab continued

Instructions Part 3: Start Excel. Open Lab 3-3 RockieView Resort and Spa Indirect Expenses Allocations. 
 1. Using the numbers in Table 3–15, analyze the effect of changing the planned indirect expenses in 

the range B18:B23 on the net incomes for each profi t center. You should end with the following 
totals in cell J15: Case 1 = $892,684.00 and Case 2 = $869,634.00. Submit the workbook or results 
for each case 
as requested by 
your instructor.

 2. Use the What-If 
Analysis button 
on the Data tab 
on the Ribbon 
to goal seek. 
Determine a 
planned indirect 
Administrative 
expense (cell B18) that would result in a total net income of $1,200,000 (cell J15). You should end 
up with a planned indirect Administrative expense of $50,159 in cell B18. Submit the workbook 
with the new values or the results of the goal seek as requested by your instructor.

Table 3–15 RockieView Resort and Spa Indirect Expense Allocations What-If Data

Case 1 Case 2

Administrative 234000 210000

Depreciation 123500 152000

Energy 67750 48000

Insurance 26200 53000

Maintenance 42000 38000

Marketing 57000 72500
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Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

• EASIER    •• MORE DIFFICULT

• 1:  Five-Year Sales Projections
You have been asked to develop a worksheet for Millennium Steel that shows annual growth for the 
next fi ve years based on the prior year’s sales and growth data. Include an embedded exploded 3-D Pie 
chart that shows the contribution of each year to the total gross margin. The data and general layout of 
the worksheet, including the totals, are shown in Table 3–16.

Enter the formulas shown in Table 3–17 in the locations shown in Table 3–16. Copy formulas A, B, and 
C to the remaining years. The gross margin for the fi ve years should equal $118,986,982.

Table 3–17 Millennium Steel Sales Projection Formulas

Formula A = Prior Year’s Sales * (1 + Annual Growth Rate)

Formula B = IF(Annual Growth Rate < 0, Sales * (Annual Cost Rate + Premium), Sales * Annual Cost Rate)

Formula C = Sales � Cost of Goods

Use the concepts and techniques developed in the fi rst three projects to create and format the 
worksheet and embedded 3-D Pie chart.

Use the Goal Seek command to determine the Year 1 annual growth rate that will generate a 
total gross margin of $125,000,000. You should end up with a Year 1 annual growth rate of 2.35%. 
Submit the workbook and results of the goal seek as requested by your instructor.

• 2: Bimonthly Projected Earnings and Expenditures
The Chesterton Trib is a small newspaper that publishes stories of local interest. Revenues are earned 
from subscriptions and the sale of advertising space. A fi xed percentage of the Net Revenue is spent on 
marketing, payroll, commissions (advertising sales only), production costs, and reportorial expenses. 
The editor has summarized the paper’s expenditures over the past year and the anticipated income from 
subscriptions and advertising on a bimonthly basis as shown in Table 3–18.

With the data, you have been asked to prepare a worksheet for the next shareholder’s meeting 
showing total revenues, total expenditures, and operating incomes for each bimonthly period. Include 
a 3-D Cylinder chart on a separate sheet that compares the six bimonthly operating incomes. Use the 
concepts and techniques presented in this project to create and format the worksheet and chart.

Table 3–16 Millennium Steel Sales Data and General Layout

Year 1 Year 2 Year 3 Year 4 Year 5 Total

Sales Formula A —

Cost of Goods  Formula B —

Gross Margin Formula C —

Assumptions

Prior Year’s Sales 35234500

Annual Growth Rate �1.75% 12.35% 5.00% �1.25% 8.75%

Annual Cost Rate 41.25% 44.00% 33.00% 43.75% 34.25%

Premium 2.90% 3.10% 4.95% 2.50% 4.50%
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One shareholder lobbied to reduce marketing expenditures by 3% and payroll costs by 5%. 
Perform a what-if-analysis refl ecting the proposed changes in expenditure assumptions. The reduction in 
expenditures should result in a total operating income of $59,696.91 or an increase of $9,118.59. Submit 
the workbook and results of the what-if analysis as requested by your instructor.

•• 3: Projected Used-Truck Savings
Cousin Abe and Aunt Esther own a paint company. Their good friend Billie Bob is retiring after 35 years 
of delivering the morning newspaper. Billie Bob has offered them the opportunity to take his place 
next year. The job requires, however, that they own a truck. They need to save enough money over the 
next six months to buy a $10,000 used truck. 

They have job orders at their paint company for the next six months: $22,150 in July, $22,480 
in August, $32,900 in September, $31,200 in October, $45,301 in November, and $32,190 in 
December. Each month, they spend 34.55% of the job order income on material, 3.00% on rollers 
and brushes, 4.75% on their retirement account, and 39.5% on food and clothing. The remaining 
profi ts (orders � total expenses) will be put aside for the used truck. Aunt Esther’s retired parents have 
agreed to provide a bonus of $250 whenever the monthly profi t exceeds $2,000. Use the concepts and 
techniques presented in this project to create and format the worksheet.

Cousin Abe has asked you to create a worksheet that shows orders, expenses, profi ts, bonuses, 
and savings for the next six months, and totals for each category. Aunt Esther would like to save for 
another used truck for $17,000. She has asked you to (a) perform a what-if analysis to determine the 
effect on the savings by reducing the percentage spent on material to 25% (answer total savings = 
$16,084.49), and (b) with the original assumptions, goal seek to determine what percentage of profi ts 
to spend on food and clothing if $15,000 is needed for the used truck (answer = 29.165%). Submit the 
workbook and results of the what-if analysis as requested by your instructor.

•• 4: College Expense and Resource Projections 

Make It Personal
Attending college with limited resources can be a trying experience. One way to alleviate some of the 
fi nancial stress is to plan ahead. Develop a worksheet following the general layout in Table 3–19 that shows 
the projected expenses and resources for four years of college. Use the formulas listed in Table 3–20 and the 
concepts and techniques presented in this project to create the worksheet.

Table 3–18 Chesterton Trib Bimonthly Projected Earnings and Expenditures

Revenue February April June August October December

Subscriptions 12178.30 8391.50 15714.50 16340.10 12567.25 12800.15

Advertising 4130.20 6425.00 4123.15 5023.30 7015.75 9273.20

Assumptions

Marketing 15.60%

Payroll 21.50%

Commissions on 
Advertising

3.25%

Production Costs 12.50%

Reportorial Expenses 5.00%
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After creating the worksheet: 
(a) perform what-if analysis by 
changing the percents of the resource 
assumptions; (b) perform a what-if 
analysis to determine the effect on the 
resources by increasing the Annual Rate Increase to 9%; and (c) with the original assumptions, goal 
seek to determine what the Annual Rate Increase would be for the total expenses to be $100,000. 
Submit the workbook and results of the what-if analysis as requested by your instructor.

•• 5: Cost of Storing Radio Isotopes

Working Together 
A government agency plans to conduct experiments that will result in some radioactive waste. Although 
the isotopes will break apart into atoms of other elements over time, agency watchdogs are concerned 
about containment costs while the material still is radioactive. The agency director has asked your 
group to prepare a worksheet showing the amount of radioactive material remaining, containment 
costs, estimated agency appropriations, and the percentage of appropriations that will be spent on 
containment every year for the next decade. The director has outlined the desired worksheet as shown 
in Table 3–21 on the next page.

Assumptions

Table 3–19 College Expense and Resource Projections

Expenses Freshman Sophomore Junior Senior Total

Room & Board $6,125.00 Formula A —

Tuition & Books 8,750.00 Formula A —

Clothes 750.00 Formula A —

Entertainment 1,025.00 Formula A —

Miscellaneous 675.00 Formula A —

Total Expenses — — — — —

Resources Freshman Sophomore Junior Senior Total

Savings Formula B —

Parents Formula B —

Job Formula B —

Loans Formula B —

Scholarships Formula B —

Total Resources — — — — —

Savings 10.00%

Parents 20.00%

Job 10.00%

Loans 30.00%

Scholarships 30.00%

Annual Rate Increase  7.50%

Table 3–20 College Expense and Resource Projections Formulas

Formula A = Prior Year’s Expense * (1 + Annual Rate Increase)

Formula B = Total Expenses for Year * Corresponding Assumption
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These formulas have been supplied:

Formula A: Amount Remaining = Original Amount � 0.5(Number of Years Stored / Half-Life)
Formula B: Containment Costs = Containment Cost Per Kilogram � Total Amount Remaining
 Formula C: Estimated Appropriations = Appropriations � (1 + Estimated Yearly Increase) 
(Number of Years Stored / Half-Life)
Formula D: Percentage Spent on Containment = Containment Costs / Estimated Appropriations

The director has asked your group to include a function that prints “Acceptable” below the percentage 
spent on containment whenever the percentage is less than 1%, otherwise print “Not Acceptable.” 

Have each member of your team submit a sketch of the proposed worksheet and then implement 
the best one. Use the concepts and techniques presented in this project to create and format the worksheet. 
Submit the sketches and workbook as requested by your instructor.

Table 3–21 Cost of Storing Radioactive Isotopes

Number of Years Stored

Number of Years Stored 1 2 3 ................................................. 10

Amount of Isotope X 
Remaining (in kg)

Formula A

Amount of Isotope Y 
Remaining (in kg)

Formula A

Total Remaining (in kg) — — — ................................................. —

Containment Costs Formula B

Estimated Appropriations Formula C

Percentage Spent on 
Containment

Formula D 

Message

Assumptions

Original Amount of Isotope X Remaining (in kg) 650

Half-Life of Isotope X (in years) 1

Containment Cost per Kilogram 1000

Estimated Yearly Increase 10.00%

Original Amount of Isotope Y Remaining (in kg) 3000

Half-Life of Isotope Y (in years) 0.45

Appropriations 6000000 
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